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About this Guide

Using this Guide

You don't need to read this Guide right the way through from beginning to
end. Read the introduction, then tum to Appendix A and Appendix B to find
out how to install and run Acom Desktop Publisher on your computer. If you
are new to desktop publishing, read the chapter Some general principles and
then work through the Guided tour. If you are already familiar with desktop
publishing, tum to the chapters Basic techniques, Working on your document, and
Giving your document a style. Use the chapters Acorn Desktop Publisher menus
and Keystroke equivalents for reference.
This is a summary of what each chapter contains:

Introduction

explains what equipment you need to use Acom Desktop Publisher and gives
a checklist of the contents of the package.

Some general principles

introduces the principles of desktop
Desktop Publisher in particular.

Guided tour

is a tutorial made up of four lessons. It introduces the basic features of Acom
Desktop Publisher. If you are new to desktop publishing, you should follow
this tutorial before exploring the more advanced features described in the
other chapters.

Basic techniques

familiarises you with the Acom Desktop Publisher windows, explaining how
to open, save, print and quit a document.

Working on your
document

tells you how to work on your document, from drawing frames to editing text
and working with pictures.

Giving your document
a style

shows you how to use a style sheet, set up your page format and master page,
create paragraph styles, and add headers and footers.

Acorn Desktop
Publisher menus

is a reference section summarising all the options in Acom Desktop Publisher
menus.
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Keystroke equivalents

provides a summary of keystroke equivalents for moving the caret (the text
cursor) and carrying out other actions.

Glossary

explains desktop publishing terms.

Appendix A

tells you how to install Acom Desktop Publisher on your computer.

Appendix B

explains how to run Acom Desktop Publisher on your computer, how to
configure the software and your machine to suit your needs, and how to use a
printer driver.

Appendix C

contains tables of the Acom Desktop Publisher character sets.

Appendix D

explains how to change the way words are hyphenated by editing the
Hyphenation Exception Dictionary.

Appendix E

lists the most commonly-encounter ed error messages.

Conventions used in
this Guide

The following conventions are used in this Guide:
• Many of the menu options in Acom Desktop Publisher have three dots •••
after them, indicating that a dialogue box will appear if you choose the
option. The option Go to page ••• is one example. To make this Guide easier
to read, these dots have been left out of the text.
• Menu names and options are shown in bold type, for example:
Use the Actual size option in the View menu.
• The names of the different modes, chosen by clicking on the icons in the
upper left of the control panel, are given in the same bold type, for
example:
Switch to paragraph mode.
• Sometimes you will need to press one key while holding down another.
This is shown like this:
Ctrl-F9
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Hold down Control and press the function key F9.
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Using the mouse

The mouse buttons are referred to by their usual names:

SELECT

MENU

ADJUST

This Guide uses the same terms for mouse operations that you will find in the
Welcome Guide and User Guide supplied with your computer:
click

press and release Select once

double-click

click Select twice quickly

drag

while holding down Select, move the mouse.

Using menus

To display the main menu, press the Menu button. Move the pointer onto the
option you want, then move it over the arrow on the right to display the
submenu. U se Select or Adjust to click on the submenu option you want.

Using dialogue boxes

Many menu options cause dialogue boxes to appear on the screen. Some of
these are very simple, only requiring you, for example, to type a number in a
box. Others are more complicated: one, for instance, allows you to set up tabs
of various sorts for displaying tables. However, they all have two features in
common:
• A dialogue box will not disappear until you click either on Cancel to
abandon the operation, or on OK if you wish it to go ahead. In fact, you
will not be able to do anything in Acorn Desktop Publisher until you do
one or the other.
• Although they can be moved around the screen, dialogue boxes cannot be
hidden behind other Acorn Desktop Publisher windows.
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screen

move windows, send them to the back, and resize them; if not, consult the

Welcome Guide supplied with your computer.
Acom Desktop Publisher gives you an additional way of manipulating
windows: when you position the pointer on a window's title bar and drag it to
the edge of the screen, it keeps going, instead of coming to a stop at the edge.
This means you can push even a large window temporarily out of the way in
order to see what is behind it. There is one exception: the document window
cannot be moved leftwards off the screen. You cannot push a window too far:
there will always be at least a tiny part of the title bar visible that you can
grab hold of again.
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About this Guide

Introduction

Welcome to Acorn
Desktop Publisher

Acom Desktop Publisher brings the exc1tmg potential of desktop publishing
to your Acom computer. It enables you to give all your documents a
professionally typeset appearance, without the cost and delay of using a print
shop. You can combine text and graphics, and use different font sizes and
designs to liven up:
• newsletters
• leaflets
• forms
• catalogues
• presentations
• posters
• manuals.

Equipment

To use Acom Desktop Publisher, you will need:
• a computer with at least lMb of RAM
• an appropriate printer (for a complete list of the printers currently
supported, refer to the Release Note supplied with your copy of Acom
Desktop Publisher).
• the RISC OS operating system.

It is best to have two floppy disc drives, or a floppy disc drive and a hard
disc. If you are using floppy discs, Acom Desktop Publisher will occasionally
prompt you to change the disc in the drive. When this happens, you must
remove the disc currently in the drive and replace it with the one requested.
Appendix B tells you in detail how to use Acom Desktop Publisher on
different Acom computers.

lntrnrt11rtinn
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Checklist

The Acom Desktop Publisher package contains:
• this Guide
• three floppy discs
• a software registration form
• a keystrip to place above the function keys on your computer
• a release note giving information about any changes made to Acom
Desktop Publisher since this Guide went to press.
Check that you have all of the above before you go any further. If anything is
missing, consult your supplier.
Fill in the software registration form and return it to Acom Computers
Limited.

Useful reading

Before you use Acom Desktop Publisher, you need to be familiar with the
desktop and filing system of your Acom computer. These are described in
detail in your Welcome Guide and User Guide.

If you are new to desktop publishing, you should now read the next chapter,
which introduces the general principles of desktop publishing and Acom
Desktop Publisher, and then use the Guided tour in the subsequent chapter to
familiarise yourself with Acom Desktop Publisher itself.

6
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Some general principles

This chapter explains the principles of desktop publishing in general and of
Acorn Desktop Publisher in particular. If you are not already familiar with
desktop publishing procedures, read this chapter before you start to use
Acorn Desktop Publisher.
Documents and their
components

Any file you create using Acorn Desktop Publisher is called a document. A
document may contain a mixture of text and graphics, laid out in columns,
using print of different font designs and point sizes. (If you do not recognise
any of the printing terms used in this Guide, the Glossary at the end of this
Guide contains definitions of most of them.) Acorn Desktop Publisher allows
you to lay out text and graphics in any format you like. Your document can
look like a letter, a book, a newspaper or a poster, for example.

Frames

All text and graphics in a document (except for headers and footers} must lie
inside a frame. Frames set out the areas of a page which will be printed. You
need to define these areas before you add any text or graphics to the page.
The frames are not printed out when you print the page; they are just a means
of letting you design your page. You can change the size or position of the
frames after you have added text and pictures if you want to.
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Text

You can type text directly into your document or import text you have
prepared using an editor or a word processor.
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You can choose the size and style of the fonts used in your text. You can also
choose to have text in bold, italic, light, or underlined type. You can change
all these features of the text as many times as you like once you have typed or
imported it.

Pictures

It is easy to add pictures to your document, too. You can import a drawing you
have prepared with a painting or drawing program like Paint or Draw (these
are part of the Applications Suite supplied with your computer), or prepare
simple drawings using Acom Desktop Publisher.
Once you have imported or drawn a picture, you can add captions and lines,
boxes, or arrows. You can also crop the picture to hide part of it, or restore
parts which were hidden earlier.

Style

The different fonts and point sizes you use in your document make up its
style. The elements of your document's style are:
• paragraph styles
• the master page
• the page format
• the style sheet.

8
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Paragraphs and
paragraph styles

The term 'paragraph', in desktop publishing, means any text unit which ends
with a Return. It can be a single line or a whole page long. Examples of
paragraphs are:
• headings
• sub-headings
• bulleted items in a list (like this one)
• paragraphs of text (called body text).
You can create a style for each type of paragraph. The style can specify all
the typographical features of the paragraph, including font, point size,
justification, tab stops, indents, bullets, and much more.
Each paragraph style is identified by a name. This means that once you have
created a style for one type of paragraph, you can use the same style again
and again by using its name.

The master page

The master page is a special page of the document. It is not printed out, but
you can display it on the screen like any other page. On the master page, you
can arrange the text and graphics frames and even add a logo to be printed
on every page. Using a master page makes it easy to give your document a
consistent appearance. Each new page you create will automatically use the
arrangement on the master page to start with, though you can add or change
frames on individual pages if you want to.

The page format

The page format determines the size and orientation of the paper, and
whether left and right pages are to be the same or different. You may want
different left and right pages when you are going to print your document on
both sides of the paper, so that alternate pages will face each other. Set up
the page format when you start a new document.

The style sheet

The styles you define for different types of paragraph, together with the page
format and master page, are stored by Acom Desktop Publisher on a style
sheet. By combining all the definitions, the style sheet describes the format,
page layout and style of the whole document. The information is stored
automatically on a style sheet for the document. If you want to use the same
format in more than one document to give your work a consistent and
professional appearance, you can save the style sheet with a name so that you
can use it for other documents, too. Use the same style sheet each time you
want to create a document with the same layout. There is more information
about using style sheets in the chapter Giving your document a style.
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Creating and styling
a document

The steps involved in creating and styling your document are:

1

Set up the page format if you are not using an existing style sheet.

2

Design a master page for your document.

3

Add pages to the document and draw frames to hold the text and graphics
if you did not define the frames on a master page.

4

Import text and drawings, or type in text and draw illustrations using
Acom Desktop Publisher's word processing and drawing tools.

5

Edit text and graphics.

6

Create styles for the different types of paragraph.

Once you have created your document you can experiment with its appearance
by changing the paragraph styles and layout.

Using modes

Acom Desktop Publisher has four different work modes. You need to be in
the right mode for the type of task you want to perform. You need to use:
• frame mode to work with frames
• paragraph mode to work with paragraph styles
• text mode to work with text

• graphics mode to work with pictures.

Later chapters in this Guide explain when you need to use each mode, and
how to switch between them.

10
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Guided tour

Introduction

If you are a newcomer to desktop publishing, you will find this chapter useful
as a quick gu ided tour through the basic features of Acorn Desktop Publisher.
In the gu ided tour, you wi ll create a short document containing text and a
picture. It is divided into four short lessons:
Lesson 1: Creating a document
Lesson 2: Working with text
Lesson 3: Using paragraph styles
Lesson 4: Adding pictures.

-

A ll four lessons contain directions for each step yo u need to take, but you can
try out ideas of your own, too. If you want to stop the gu ided tour at any point
and return to it later, turn to the section Finishing your session at the end of this
chapter to see how to save the work you have done.

If at any time during the guided tour you find you have displayed a dialogue
box you don't want, click on the box marked Cancel and it will disappear. If
you wish to remove a menu from the screen, click anywhere outside the menu.
This chapter assumes that you have reached the po int where the Acorn
Desktop Publisher icon is on your icon bar, like this:

~
llilliG~I
:8 Econet
:4
Acom Desktop Publisher icon

To find out how to get to this point with your computer system, read Appendix
A and Appendix B, near the end of this Guide.

Guided tour
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Lesson 1: Creating a
document

In this lesson you will:
• open an empty, new document
• identify the Acom Desktop Publisher windows
• display the Help information
• design a master page for your document by creating, copying and moving
frames

-

• view a page at a different size
• draw frames on the master page
• copy, move and resize frames
• insert a blank page into your document.
Opening a new
document

Once you have loaded Acom Desktop Publisher you are ready to start. The
first step is to decide on the page layout for your document:
1 Press Menu on the Acom Desktop Publisher icon on the icon bar.
2 Click Select on the Page format option.
3 A dialogue box appears:

Pau for..at
Page size:
211 x 291
<$>R4
<)Letter 1.5 x 11.1 in
<)Legal
1.5 x 14.1 in
<)Note
5.5 x 1.5 in
<)User ID!] x 1297.~ ~
Orientation: llaster paps:
<$> Pertrai t <$>Bil alike
<)Landscape <)Left & ritlat

•

I
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4 Click on OK to choose the default page layout (portrait A4 with left and
right pages the same). Two windows will appear on your screen:
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Publisher windows
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The window on the right is the document window; it overlaps the control panel, on
the left. The frames, text and graphics which make up your document will
appear in the document window. The browser, in the centre left of the control
panel, shows options you can choose. These will be filenames, styles or tools
depending on what you are doing.
The toolkit is at the top lefthand comer of the control panel. It has four icons,
one for each of the four modes of Acom Desktop Publisher, frame, paragraph,
graphics and text modes. Notice that the top lefthand box is highlighted to
show that you are in frame mode. Acom Desktop Publisher always starts up
in frame mode because the first step in creating a document is to draw the
frames that will hold your text and pictures.
A full description of the control panel is given in the chapter Basic techniques.
The pointer changes to an icon that looks like an open cross when you move it
into the document area. In this Guide, it is referred to as a 'pointer' whatever
shape it has.
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How to get help

Acom Desktop Publisher will provide instant help information at any point.
To display the Help information, follow these steps:
1 Press Menu within either the document window or the control panel.
2 Move the pointer to the Help menu and across the arrowhead to its right. A
submenu showing the various Help options appears on the screen.
3 Move the pointer to one of these options and press Select to display Help
information relating to the topic. If you are using floppy discs, you will
probably be asked to swap discs at this point.
4 Click on the Next box or press Return to look at the next page of Help
text. Click on Previous to look at the preceding page. When the last page
of help is displayed, the Next box will appear in grey, indicating that this
option is not available.
5 To remove the Help text, click on Exit.

Designing the master
page

If you want all the pages in your document to have the same layout, you
should use a master page. This will act as a template for all the new pages
you add to the document. On the master page, you can draw frames and add
any text or graphics you want to appear on every page.
To display the master page:
1 Press Menu to display the main menu.
2 Move the pointer to the Page menu and across its right arrowhead. A
submenu appears.
3 Choose Go to page by moving the pointer to it and pressing Select.

14
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4 When the Go to page dialogue box appears, click on the option to Go to
master page. The master page appears. If you have just started Acorn
Desktop Publisher for the first time, it will look just like the first page of
the document, but the page icon at the bottom lefthand corner of the control
panel indicates that the master page is being displayed:
DesktoD Publisher

f!lt31

page~

icon
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MRSTER

-
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Viewing a page at
different sizes

1¢ 11

~u ~
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At the moment, yo u will only be able to see part of the master page on
screen . This is because you are viewing the page at Actual size. T o display
the whole master page:
1 Press Menu to display the main menu .
2 Move the pointer onto the View option, and move it over the arrowhead to
display the View submenu . The Actual size opt ion h as a tick by it, showing
that this is the size you are using.

1 i:;

3 Move the pointer to Full page and click Select. The document window now
looks like this:
~ I 01
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The master page has six dotted boxes on it. These are called column guides.
The column guides are there to help you draw and position frames precisely.
You can't type directly into these column guides; you have to draw a frame
first. In this lesson, you are going to draw three frames on the master page,
each one two columns wide.

Drawing frames

Draw two frames on your master page as follows:
1 Position the pointer at the top lefthand comer of the first column. This will
be the top comer of the first frame .
2 Holding down Select, drag the pointer to the right, and down to create a
frame which covers the first two columns. The pointer changes shape to a
pointing hand while you do this.
3 Release Select. A frame appears with eight little boxes or handles around
its edges. The handles indicate that the frame is currently selected.

-

4 C lick Select somewhere in the document window outside the column guides,
to deselect the frame you have drawn. The handles disappear.
5 Draw a second identical frame across the middle two columns.
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You have n ow drawn two of the frames. Since the three frames on this page
will be identical, you can copy one of these two frames instead of drawing the
final one. Of course, you could simply draw the third frame, just as you drew
the second, but this method is included to introduce you to the idea of copying
objects such as frames.

Copying and moving
frames

There are three stages to making a copy of a frame; you have to se lect and
copy the frame, then paste the copy onto the page, and finally move the copy
to where you want it.
Select one of the frames by clicking somewhere inside it. You can only
have one frame selected at a time.
2 Press Menu and display the Frame submenu.

17

3 Select Copy frame to make a copy of the selected frame. The copy is
stored in the computer's memory (not on disc), but will not appear until
you paste it onto the page.

~

4 Next, select Paste frame in the Frame submenu to paste the copy onto the
page. It appears overlapping the original frame, and the copy is now
selected, not the original.
5 Now you need to move the copy to the correct place. Position the pointer
inside the new frame.
6 Press and hold down Select.
7 The pointer changes shape to a flat hand. Drag the frame into position and
release Select.
Your screen should now look like this:

" I CJ I
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Resizing frames

If you need to, you can change the size and shape of a frame by using its
handles. Simply position the pointer on one of the handles and drag the
frame by the handle until it is the size and shape you want:
~1 (:31
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Dragging a corner handle will reduce or enlarge the frame both vertically and
horizontally.
Dragging a centre handle will lengthen or shorten the frame either vertically

or horizontally.
Try altering the size and shape of the last frame you added to the page.

G11irlArl tour
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Inserting a page

Now that you have created the master page, you are ready to add a blank
working page to your document:
1 Select Go to page in the Page menu. A dialogue box appears:

&oto Pate
Goto Pitt

D

l&oto aaster page!
I OK I lcancell
2 Type 1, then click on OK or press Return to display page l. Acom Desktop
Publisher creates a copy of the master page automatically.

Overview

In this lesson, you drew the frames on your master page and inserted a blank
working page into your document. In the next lesson, you will read in a story
from disc and edit it, then add a banner headline.

Lesson 2: Working
with text

Now that you have drawn your frames, you can impart (load in) text or
pictures created with another program. In this lesson, you are going to:
• import a story (text file) created with Edit
• zoom in and out on the text

-

• edit the story
• add a headline to the story and give the headline frame a border.

Importing a story

First, you are going to import a story called Brochure. This is on the Examples
disc. Now import the story into your document:
1 Make sure that none of the frames is selected by clicking outside the
frames but within the document window.
2 If you are using a floppy disc system, insert the Examples disc into the
drive and click on the drive icon to open the directory window. If you are
using a hard disc, open a window for the directory containing the examples.
3 In the subdirectory Stories, find the icon for the story called Brochure and
move the pointer to it.

20
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4 Pressing Select, drag the icon to the document window or to the control
panel. The name of the story appears in the browser (the window in the
centre left of the control panel).
5 Click on the Close icon on the directory window to close it, if you wish, or
on the Back icon to send it to the back.
6 Click on the first frame to select it, then click on the story name Brochure in
the browser. The story pours into the frame until the frame is full:
~ICll

untitled*

The frame has a dotted bottom edge; this shows that not all the story would
fit and there is some unplaced text.
7 Select the second frame and click on Brochure again. The text pours into the
second frame. Repeat the step for the third frame; this places the rest of
the story.

21

The browser

In frame mode the browser shows a list of all the stories (text files),
drawings (line art files), and paintings (picture files) which you have
imported into the document.
Click on the title STORIES at the top of the browser and notice how it
changes to LINE ART. The browser is empty because you have not imported
any line art files into the document. Click again on the title and it changes to
IMAGES. Again, the browser is empty.
Now click on the browser title again to display STORIES.

View sizes

At the moment you are in Full page view. This is useful for drawing frames,
checking your page layout, and other large-scale work, but to do detailed
work, you need to zoom in on the page. Acom Desktop Publisher has five view
sizes:
• full page view
• double page
• actual size
• half size
• double size.
These sizes are offered in the View menu. Experiment with the view sizes. If
you use Adjust to click on the options, the menu will stay on the screen while
you work; this is particularly useful when you are trying out several
alternatives in succession. It may take a moment for the computer to display a
new size. Appendix B explains how you can minimise this delay.
Finally, select Actual size again, so that the document window looks like this:
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Don't forget that you can also use the document window's normal T oggle size
and Adjust size icons to change the amount of the document you can see, and
the scroll bars to change the part of the document visible in the window. If
you are unsure about how to use these, refer to the Welcome Guide or User
Guide supplied with your computer.

Editing the story

You can edit any story after importing it, though it is best to do any extensive
ed iting before you import it and just do minor corrections using Acorn Desktop
Publisher: You must do all editing in text mode.
In the story you have imported, there is a typographical error in the second
paragraph of text: it should say 'words and pictures' instead of 'worms and
pictures'. You can correct this easily:

-

-

Switch to text mode by clicking on the T-shaped text mode icon in the
toolkit. When you move the pointer into the work area it changes to a caret -

a vertical bar rather like an I.
2 C lick the pointer on the word 'worms' to place the text cursor within it. The
text cursor is also a caret; it marks the place on the page where any text you
type will appear.

Press Delete or f-i to delete the m, then type d to finish the correction.

Typing in a headline

To complete this lesson, add a banner headline to the top of the page. First
you need to draw a frame to hold the headline text:
Go back to full page view by selecting Full page in the View menu.
2 Switch back to frame mode by clicking on the frame icon in the toolkit.
3 Now draw a long thin frame at the top of the page so that it overlaps the
other three frames:
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It doesn't matter if you don't get the frame exactly the right shape and size, as
you can always resize it or move it later.
When you've finished this new frame, the text in the frames underneath moves
out of the way to make room for it. This characteristic is called repelling text.
You can add a border to the headline frame while still in frame mode:

1 Make sure the headline frame is still selected. If it isn't, click on it to
select it.
2 C lick on Frame border in the Frame menu to display the Frame border
dialogue box.
3 Click in the box to the left of the All around option.
4 Click on the box to the left of the double-line border style at the bottom of
the list of options and click on OK A double-line border appears around
the frame. Don't worry if this doesn't look quite right on the screen: it will
look fine when you print your document.
Now you can type in the headline text:
1 First, switch to Actual size so that you can see what you are typing.
2 Switch back to text mode.
3 Click inside the headline frame to place the text cursor within it.
4 Press Caps Lock. and type in the words:

ACORN DESKTOP PUBLISHER
The document window now looks like this:
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In the next lesson, you will learn how to make this headline bigger, centre it
in the frame, and so on.

Overview

In this lesson, you imported a story from disc, poured it into frames, zoomed
in and out on it, and edited it. You also drew a banner frame and typed a
headline into it. In the next lesson, you will learn how to work with paragraph
styles.

Lesson 3: Using
paragraph styles

Every paragraph of text in an Acom Desktop Publisher document is tagged
with a paragraph style. The paragraph style controls several different
typographic features, including:
• the typeface or font used for the text
• the point size of the text
• whether or not the text is hyphenated
• the justification format of the text.
As every paragraph of text is controlled by a paragraph style, a change to
any of the features of a particular style will affect all paragraphs tagged
with the style.
Acom Desktop Publisher has several default paragraph styles which you can
use. You can also develop your own styles.
In this lesson you will learn how to use paragraph styles to control:
• font and point size
• bullets
• hyphenation
• justification.
To work with paragraph styles you need to be in paragraph mode.

Changing font and
point size

Switch to paragraph mode by clicking on the paragraph icon in the toolkit.

11

The pointer now changes shape into a paragraph symbol when you move it
into the document window.
To see what style a paragraph is tagged with already, click on it and look at
the paragraph style name which is highlighted in the browser. Select a few of
the paragraphs in tum by clicking the pointer on them. You will see that every
paragraph in the story is tagged with the style called body text.

Guided tour

You can tag some of the paragraphs with a different style:
Select the first section heading 'Power over the printed page' by clicking
the pointer on it. The section heading is highlighted.
2 Click on the style name SUBHEAD in the browser. The section heading
changes size and font to the subhead style ( 16 point Homerton bold):
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3 Repeat the tagging process with the other section headings: EASY TO
LEARN, FLEXIBILITY and AWARD-WINNING TECHNOLOGY. You
will have to scroll the document in the window to show some of the section
headings.
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You can also emphasise each of the small paragraphs with a bullet. Do this
in the same way as you tagged the section headings:

-.

1 Select the single-word paragraph 'newsletters'.
2 Click on the style name BULLET in the browser. The result should look
like this:
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3 Repeat the tagging process with as many of the other feature paragraphs as
you like.
You can give the headline you created its own paragraph style:
1 Bring the whole headline frame into view by selecting Half size view and
scrolling up to the top of the page.
2 Tag the headline text with the style HEADLINE by clicking on that style
name in the browser.
The headline text is now in a large display point size (36 point NewHall)
and may not fit into its frame . If this is the case,
Switch back to frame mode.
2 Click the pointer in the headline frame to select it.
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3 Resize the frame by dragging the lower centre handle downwards until all
the text is visible within the frame:
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If the frame is too large instead of too small, you can, of course, make it
smaller by dragging the lower centre handle upwards.

Turning hyphenation
off

Whenever you load any text into a frame, it is normally hyphenated: long
words are broken at suitable points in order to spread the text as evenly as
possible between lines. Try turning hyphenation off for the paragraphs
tagged as body text:
Switch back to paragraph mode and Actual size view, then select a
paragraph with a hyphenated word in it (eg 'completely' in the second
body text paragraph).
2 Select Edit style in the Paragraph menu.
3 When the Paragraph style dialogue box appears, click on Options. A new
section of the dialogue box will appear on the righthand side.
4 Turn hyphenation off by clicking on the box next to Hyphenation allowed
(so that the box is no longer crossed), then click on OK.
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The word 'completely' moves onto a new line, and extra space is added
between the words on the line it was on, to justify the line:
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At the moment, all the body text paragraphs are justified, with straight left
and right margins. You can change the justification format for body text to
flush left text:
1 Select one of the paragraphs of body text.
2 Select Edit style in the Paragraph menu.
3 In the Paragraph style dialogue box, click on Format.
4 Select Flush left and click on OK
All the body text paragraphs now have straight left margins and uneven right
margins:
I
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Overview

In this lesson, you learned how to use paragraph styles to control the look of
your text, including changing font and point size, turning hyphenation off, and
changing the justification format. In the next lesson, you will add a picture to
the document.
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Lesson 4: Adding
pictures

Now you have imported and styled some text, you can add a picture to the
document. In this lesson, you will:
• draw a frame to hold a picture
• add another page to the document
• import an image
• crop the imported picture.

Drawing a frame to
hold a picture

First draw a frame for the picture:
Switch back to Full page view.
2 Switch to frame mode.
3 Now draw a frame on the righthand side of the page to hold your picture:
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Since there is now less room on page 1 to hold the text of the story, you need
to create more space for it. You can create a new page and pour the rest of
the story into it:
Select Add page in the Page menu. A copy of the master page appears and
the page icon shows that this is page 2.

-

31

2 Select the first frame on page 2 and click on the story name in the browser
to pour the rest of the story into the frame. Repeat this process until all of
the story is placed in frames again.
3 Click on the arrow to the left of the page icon to return to page 1.

Importing a picture

You are going to import a picture and load it into the frame. For the
illustration here, we will use the image file called Eagle, which you will find
on the Examples disc, in the directory called Images. You can use any of the
pictures in this directory, or in the LineArt directory. To import the picture
c;alled Eagle and load it into a frame, follow these steps:
Open a directory window for the directory Examples.Images.

2 Make sure no frames in your document are selected.
3 Position the pointer on the icon for the Eagle picture.
4 Hold Select and drag the icon to either the control panel or the document
window and release Select. The name of the picture appears in the browser.
5 Click on the Close icon of the directory window, if you wish, to close it.
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6 Select the frame you drew for the picture and click on the picture name in
the browser. The picture appears in the selected frame. Your document
window now looks like this:
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This picture is a drawing created with a painting program (in fact, with
Clare's Artisan), so the browser title has changed to IMAGES and the
browser displays the name of the picture.

Cropping the picture

If after you have imported a picture you decide that you don't want all of it, it
is easy to crop or cut off any unwanted areas of the picture, and leave the part
you do want filling the frame . Try it on the picture you have just imported:
Switch to Actual size to see the picture in more detail. (You may have to
scroll the page to bring the picture into view.)
2 Make sure the picture is still selected and click on Crop picture in the
Imports menu.

3 The pointer changes shape to a pair of scissors.
4 Position the scissors near the top lefthand corner of the picture and use
Select or Adjust to drag a dotted box around the eagle's head.

Guided tour
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5 Release the mouse button. The cropped portion now fills the frame:
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6 Click anywhere within the browser or document windows to tum off
cropping.

If you want to restore the original picture, select the picture frame again and
click on the name of the picture in the browser.
Finishing your
session

When you have finished working through the guided tour, you may want to
save your document to disc before leaving the program. You can then work on
it again or print it out when you've learnt more about using Acom Desktop
Publisher.

Saving your document

A new document always has the name 'untitled' until you give it the one you
want. You can give the document a new name when you save it. The saving
procedure is exactly the same as for other RISC OS applications: full details
are given in the Welcome Guide and User Guide supplied with your computer.
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1 If you are using floppy discs, insert the disc on which you want to save the
documen t in the disc drive. The disc must have been formatted: if it has not,
and you are not sure how to format a disc, refer to your User Guide. The
rest of the process is common to floppy and hard discs.
2 Click on the icon for the drive you want to use, thus displaying its root
directory. Open a window for the directory where you want to save the
documen t.
3 From the File submenu, use the Save document option to display the Save
as dialogue box.
4 Use the keyboard keys to delete the present name and give the documen t
the name you want.
S Drag the icon in the Save as box to the directory window and release Select.
6 The documen t icon appears in the directory window when it has been saved
to disc. Close the directory window, if you wish, by clicking on its Close box.

Closing your current
document

To remove the documen t you are working on from memory, leaving Acorn
Desktop Publisher ready for another documen t, click on the Close icon of the
documen t window. If there are any unsaved changes in the documen t, you will
be reminded of this (note also that an asterisk appears to the right of the
documen t's name in the title bar when there are changes you have not saved).
If you want to abandon the documen t without saving the changes, click on
Abandon. Otherwis e, click on Continue and go through the normal Save
procedure, as described above.

Quitting Acorn
Desktop Publisher

To remove Acorn Desktop Publisher from your computer 's
altogethe r, press Menu on the icon bar icon and select Quit.

Overview

In this guided tour, you have learned many of the technique s you need to
create and lay out Acorn Desktop Publisher documen ts. The rest of this guide
describes more fully what you can do with the applicatio n. If you have any
questions about particular features, refer to the chapters Basic techniques,
Working on your document and Giving your document a style. The chapter Acom
Desktop Publisher menus explains the function of each of the menu options.

Guided tour
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5 Release the mouse button. The cropped portion now fills the frame:

untitled •
ACORN DESKTOP
PUBLISHER

'o

Basic techniques

This chapter first of all explains how to start Acom Desktop Publisher and
describes the two windows you will see on the desktop. It assumes that you
have read Appendix B, which tells you how to use Acom Desktop Publisher
with different systems.
The chapter continues by telling you how to move around your document, and
how to save, print and quit a document.

The Acorn Desktop
Publisher windows

There are four ways to open the Acom Desktop Publisher windows and start
using the application:
• To open an existing Acom Desktop Publisher document, double-click on its
icon in the directory window. The application will be loaded (so that its
icon appears on the icon bar) along with the document you have selected.
• To open a new document with an existing Acom Desktop Publisher style
sheet, double-click on the style sheet icon in the directory window. Again,
the application will be loaded along with the style sheet.
• To open a completely new document with the default style sheet, doubleclick on the Acom Desktop Publisher icon in the directory window. Then
click on the icon that appears in the icon bar. The default style is A4
portrait format, with all pages alike, and four defined paragraph styles.
• To open a new document and design your own style sheet, double-click on
the Acom Desktop Publisher icon in the directory window. Then press
Menu on the icon bar icon, and select Page format. The Page format
dialogue box appears, allowing you to choose your own page dimensions.
When you have made your choices, click on OK and the Acom Desktop
Publisher windows appear on the screen.
The two windows are the document window (on the right) and the control
panel. The document window overlaps the control panel when the windows
first appear, but you can move either of them, bring a window to the front or
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following sections look at these windows in detail.

The document window

The document window looks like this when you open a new document with the
default style sheet:
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It is just like any other RISC OS application window. You can:
• move it by dragging on the Title bar
• scroll around it using the scroll bars and arrows
• send it to the back with the Back icon
• bring it to the front by clicking on its Title bar
• enlarge it (and shrink it again) with the Toggle size icon
• resize it with the Adjust size icon.

Basic techniaues

For full details of all these operations, refer to the Welcome Guide or User
Guide supplied with your computer. In addition, you can slide the window
partly off the screen by dragging on the Title bar.
The portion of the page that you see in the document window depends on the
view size you have chosen. You may see a whole page, part of a page, or two
whole pages. The view size options are described in View sizes later in this
chapter.

The control panel

The control panel can be moved around (or partly off) the screen, and sent to
the back or brought to the front, but its size cannot be changed.
The control panel contains the toolkit, browser, page icon, and function key
boxes.
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The toolkit

The toolkit is used to switch between the four work modes of Acorn Desktop
Publisher. The icons are:

frame
icon

paragraph
icon

text
icon

graphics
icon

You have to be in the right mode for the task you wish to perform. You need
to use:
• frame mode to draw, size, move and style frames
• paragraph mode to select, assign and change paragraph styles
• graphics mode to create and edit pictures
• text mode to type in and edit text.
Click Select on the icon in the toolkit to choose the mode you want to work in.
For example, to use the graphics tools, click on the graphics mode icon.

The browser

The contents of the browser vary according to which mode you are using:
• In frame mode, it contains the names of the text or picture files you have
imported into your document.
• In paragraph mode, it contains the names of the paragraph styles in the
style sheet you are using.
• In graphics mode, the browser is replaced by the icons representing the
graphics drawing tools.
• In text mode, it contains a list of text styles.
The browser can be scrolled, if necessary, using its scroll bar or scroll arrows .
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The page icon

The page icon at the bottom lefthand comer of the browser window tells you
which page(s) are currently displayed on the screen.

D
1

The top comer of the page is folded down on the left for a lefthand page and
on the right for a righthand page. Pages can be 'turned over' by clicking on the
arrows to the left and right of the page icon. If the last page of your document
is displayed, you can use the page icon to add a new page. C lick on the right
arrow of the page icon and when the dialogue box appears, click on Yes to
create a new page.

The function key boxes

The function key boxes show you what task is allocated to each function key.
You can click on the function key boxes instead of using the function keys. For
example, you can insert a soft hyphen or a fixed space at the cursor position
either by clicking on the appropriate function key box or by using the
keyboard.
The section Assigning function keys in the chapter Giving your document a style
explains how to assign paragraph styles to the function keys.

The pointer

The shape of the pointer changes according to what you are doing and where it
is:

~

anywhere outside the work area

JL
ir

inside the work area in frame mode

11

inside the work area in paragraph mode

~

inside the work area in graphics mode

I

inside the work area in text mode
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There is also a special hourglass icon which replaces the pointer when the
computer is carrying out a lengthy operation such as accessing new fonts. You
will not be able to do anything with Acorn Desktop Publisher while this icon
is on screen.

The menus and
dialogue boxes

Press Menu on either window to display the main menu.
A menu item that leads to a submenu will have an arrowhead to the right of
it. Move the pointer across the arrowhead to display the submenu. To choose
an option, click on the option when it is highlighted in the menu.
Clicking on an option with Adjust retains the menu on screen after the option
has been carried out, provided the option is not one that causes a dialogue box
to appear. Clicking on an option with Select carries out the command and
removes the menu from screen. When a dialogue box appears, the menu
vanishes whichever button you use.
A menu can be moved around the screen in the same way as any other
window, by dragging on its Title bar. If you want to remove all menus from
the screen, move the mouse off the menus and click Select. Full details of the
menus used in Acorn Desktop Publisher are given in the chapter Acorn

Desktop Publisher menus.
Dialogue boxes can also be moved around the screen. However, you cannot
move an Acorn Desktop Publisher window in front of a dialogue box that
needs a response.

View sizes

Acorn Desktop Publisher has five view sizes:
• Full page displays all the page on the screen.
• Double page shows two facing pages side by side.
• Actual size shows the page at the size it will be when printed.
• Half size shows the page at half its printed size and is useful for checking
layout.
• Double size shows the page enlarged for detailed work.
Use the View menu or the keystroke equivalents to change the view size,
depending on what sort of work you are doing. The keystrokes are all listed
in the chapter entitled Keystroke equivalents.
On most monitors, the view size at Actual size is exactly how your document
will appear on paper when you print it.
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If you switch to Full page when your document window is less than the height
of the screen, you will find that the Full page view preserves the same
window height. This may be too small for convenience, and you will be
unable to stretch the window using the Adjust size icon, because the whole
page is already shown. To avoid this problem, use the Full size icon or the
Adjust size icon to make the window as tall as possible before switching to
Full page view.

Moving around your
document

You can move from page to page within your document in two ways:
• by clicking on the arrows to the left and right of the page icon to move
backwards or forwards a page.
• by using the Go to page option in the Page menu. When you choose this
option, the Go to page dialogue box appears. Type in the number of the
page you want to display, then click on OK, or click on the box to display
the master page. If you don't type in a number before you click on OK, the
first page of your document will be displayed . If you type a number
greater than the number of the pages in your document, the last page will
be displayed .

Printing your
document

Before you print your document, you must load a printer driver. Appendix B
tells you how to do this.
Once a driver has been loaded, use Print in the File menu to print the
document you are working on. A dialogue box appears allowing you to choose
various options, such as the number of copies to print, page range, forward or
reverse order, and so on. If you are printing more than one copy and choose
Collate, each copy will be printed in order (1 , 2, 3, ... 1, 2, 3, ... ). If you don't
choose Collate, you will have to sort the pages later as they will be printed in
batches (1, 1, . .. 2, 2, ... 3, 3, ... etc).
When you click on OK, the title of the dialogue box changes to Printing, and
a panel at the bottom indicates which page is currently being printed. If you
wish to stop printing for any reason, click on Interrupt (don't be surprised if
the response takes some time).

Saving your document

When you have finished working on a document, you can save it using a new
name or the name it already had. Use the Save document command in the
File menu:
1 Open a window for the directory in which you want to save the document.
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2 Use the Save document option in the File menu to display the Save as
dialogue box.
3 If the document already exists on disc and you want to save it with the same
name, click on the OK box or drag the document icon to the directory
window. You will see a dialogue box warning you that you will overwrite
the existing document on disc if you continue. Click on OK to go ahead.
4 If your document is new or you wish to rename it, type the new name into
the dialogue box before dragging the icon to the directory window.
You can carry on editing the document after saving it.

If the document does not already exist on disc and you click on the OK box
without dragging the document icon to a directory window, a dialogue box
appears, reminding you of what you have to do. Clicking on OK will display
the Save as dialogue box. Provided the window for the directory where you
want to save the document is visible, you can then follow the saving procedure
described above. However, if the window you want is not on screen, first click
anywhere outside the Save as box to remove it from the screen, then open the
directory window you want and start the save procedure again.

Quitting Acorn
Desktop Publisher

If you have been working on a document, close it by clicking on the Close icon
of either the document or the control panel. If you have made changes to your
document since you last saved it, a dialogue box gives you the chance to save
your document. Click on Abandon if you do not wish to save the changes, and
the Acorn Desktop Publisher windows then close. Click on Continue if you
wish to save the changes, then go through the normal Save procedure.

If you have finished using Acorn Desktop Publisher, you can remove the
program from the computer's memory to free more space for other tasks:
Move the pointer to the Acorn Desktop Publisher icon in the icon bar and
press Menu to display the icon bar menu.
2 Click on Quit to remove Acorn Desktop Publisher from memory. The
application icon disappears from the icon bar.
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Working on your document

by Acorn
This chapter describes the working modes and layout aids provided
to:
use
Desktop Publisher, and then explains the techniqu es you need to
• draw frames
• work with text
• work with pictures.

Modes

ate for
Acorn Desktop Publisher has four working modes, each appropri
to
want
you
task
different types of task. You must be in the right mode for the
perform.
This is
When you first start Acorn Desktop Publisher, it is in frame mode.
will
which
because the first task in a new docume nt is to draw the frames
can
you
hold the text and graphics. When you have designed your layout
switch to a different mode. Use:
• text mode to add or edit text
• graphics mode to add or edit pictures
• paragrap h mode to define and choose paragraph styles.

Layout aids

.--,
Displaying the rulers

page
Before you can start work on a new docume nt you need to design your
your
g
designin
make
layout and draw frames to hold the text and graphics. To
you
help
to
aids
pages easier, Acorn Desktop Publisher provides some layout
column
and
rulers
position frames quickly and accurate ly. These are the
guides.
to help
You can use the rulers at the top and lefthand edges of the work area
lines
thin
pointer,
the
move
you
I
you draw and position frames exactly. When
on the rulers follow its vertical and horizontal movements.
option is
To display the rulers, click on Show rulers in the View menu. This
ticked when the rulers are displayed.

You can change the unit of measurement used on the rulers by choosing the
Units option in the View menu. The units available are:
• picas and points
• inches and tenths
• inches and eighths
• centimetres
• millimetres.
The unit you have chosen is indicated in the top lefthand comer where the
rulers meet. The units you choose for the rulers are used for all
measurements in the program (for example, in the Set column guides
dialogue box).

If the rulers are displayed, you can also change the unit of measurement by
clicking on the units description in the top lefthand comer where the rulers
meet. The units change in the order in which they appear in the Units
submenu.

Setting up the column
guides

You can also use the column guides to help you pos1t1on frames on the page.
These are boxes with dotted outlines which appear on each page of your
document, but which are not printed out. When you open a new document,
there are some column guides already drawn on the empty page (the exact
!'lumber will depend on the page format you have selected). To set the column
guides, click on Set column guides in the Page menu. The Set column guides
dialogue box appears:

Set colunn quides
Nunber of colunns
Dinensions:
Top nargin
Botton nargin
Left Margin
Right nargin
Gap between colunns

[[]@]@]
inches

~
[ID

[]D
~
~

ICancel I

OK

This dialogue box allows you to set the number of columns you want; you can
have up to nine columns on each page.
You can also set the left and right, top and bottom margins, and the gap to be
left between the columns.
You can hide the column guides by clicking on Show frames and columns in
the View menu. This option is ticked when the column guides are displayed.

r
Working with frames

Text, pictures, and graphics in a document are always placed in frames.
Frames are not printed out unless you choose a frame border for them (see
Frame borders and tints in this chapter). Each frame can be resized, moved,
copied, or deleted, so it doesn't matter if you don't get your frames right the
first time. You can have up to 100 frames on a single page, and up to 8,192 in
a document. This section tells you how to draw and manipulate these frames.
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selected frame

Moving frames

If you draw a frame in the wrong 1
page, you can move a frame:
p ace, or want to alter the layout of your
1 Select the frame you want to move.

2 Drag the frame to its new location. An
mo
d
outline of the frame follows your
vements an serves as a placement guide:
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Drawing frames

Follow these steps to draw a frame:
Switch to frame mode. (If you have just opened a new document, Acom
Desktop Publisher will already be in frame mode.)
2 Position the pointer within the document window where you want the top
left comer of the frame to be. Press Select and then drag to the opposite
comer of the frame.
3 Release Select.
Don't worry too much about accuracy as you can easily move or resize the
frame afterwards.
You can draw frames anywhere on a page, even within or overlapping existing
frames. You cannot, however, start drawing a new frame from a point inside
an existing one which is already selected. You must first deselect the frame by
clicking somewhere outside it.

Resizing frames

To change the size or shape of a frame:
C lick anywhere inside the frame to select it. Eight small boxes called
handles will appear around its edges.
2 Position the pointer on one of the handles, then use Select to drag the
frame by the handle until it is the size and shape you want:
•Dragging a comer handle will reduce or enlarge the frame both vertically
and horizontally.
•Dragging a centre handle will lengthen or shorten the frame either
vertically or horizontally.
You can resize a frame using either Select or Adjust. If the frame is empty,
the effect is the same whichever you use, but if the frame contains a picture,
the picture will be cropped if you use Adjust and rescaled to fit the frame if
you use Select. More details of this are given in Cropping a picture, later in
this chapter.
A frame can be resized even if it is partly hidden behind other frames. When
you select a frame, the handles become visible through any frames on top of
it and you can resize the frame in the usual way.
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selected frame

Moving frames

If you draw a frame in the wrong place, or want to alter the layout of your
page, you can move a frame:
1 Select the frame you want to move.
2 Drag the frame to its new location. An outline of the frame follows your
movements and serves as a placement guide:

'"'--•~:

.... - ......... ··-· , , . ....1--· ,......., . . . ~+

LLO

3 When the frame is where you want it to be, release Select to place it in its
new position.
You can only move a frame in this way within a single page, even if you are
displaying a double page. To move a frame to a different page, use the cut
and paste facilities described later in this section.

More precise resizing
and moving

If you want to resize or position a frame more precisely, you can specify a
size using the Size and position option in the Frame menu:
1 Select the frame you want to resize.
2 Either double-click on the frame or click on Size and position in the Frame
menu. A dialogue box appears showing the size and position of the frame.
The units given are the same as those set for the rulers.
3 Alter the Horizontal position and Vertical position to the values you want;
the positions are set relative to the left and top of the page.
4 Alter the Width and Height entries to change the dimensions of the
selected frame.
5 Click on OK to apply the new measurements to the frame.

Size and Position
inches
Difllensions
Horizontal position [!!]
Uertical position
[!JLJ
Width
~
Height
[!]!]

I
Snapping frames to
the column guides

Ok

I

ICancel I

Frames will automatically snap to the column guides and ruler divisions when
resized or moved. This means that the left or right edge of a frame near a
column guide will jump to align itself exactly with the guide. The top and
bottom edges of each frame will snap to the current ruler divisions.

If you don't want frames to snap to column guides and ruler divisions you can
turn snapping off by clicking on Snap to guides in th~ Frame menu. This
option is ticked when snapping is turned on.
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Stacking frames

If you position a frame so that it overlaps another frame, you can stack the
overlapping frames in any order you want. You can place one frame behind
another, or choose the frame you want to bring to the front. To move a frame
to the back of the stack:
1 Select the frame you wish to send to the back.
2 Click on Send to back in the Frame menu.
To bring a frame to the front of the stack:
1 Select the frame you want to reveal.
2 Click on Bring to front in the Frame menu.
Be careful when using Send to back, as it will place the selected frame
behind all the items on that area of the page. If you then deselect the frame,
it may be completely covered over. To make it accessible again, you would
then have to use Send to back on each of the frames in front of it.
You can prevent a frame obscuring any text in a frame behind it by making
the top frame repel text in the covered frame. This keeps the text visible. This
feature is described in Repelling text later in this chapter.

Frame borders and
tints

Normally, frame borders are not printed out when you print your document.

If you do want to print a border, you can choose which sides you want it to
appear on, and select one of four styles. To add a border to your frame:
Select a frame.
2 Click on Frame border in the Frame menu.

Fra111e border
Style:
Options:
()A 11 around 1>
4;i. Ho border
()
()
0Above
()
0Left
0Right
0Below

I

\A/nrl.rinn nn

\/l"\t

OK

I

1r ~t"\t""t 1mo.nt

3 Click on All around to give a complete border to your frame, or click in the
appropriate box( es) for a border on one or more sides.
4 Click on the border pattern you want.
5 Click on OK to add the border to your frame.
You can also choose a background tint for your frame. Select the Frame tint
option in the Frame menu:

Fraflle tint
(>Transparent

4>0
<>D
<>D
<>D
OK

<>•
<>•
<>•
<>•
!Cancel I

1 Click on the box next to the tint you want, or choose Transparent to give the
frame a transparent background.
2 Click on OK to add the tint to the frame.
You will need to use this option if you have overlapping frames and want the
contents of the frame behind to show through. The example opposite
illustrates this: the acorn lies in one frame behind the larger transparent
frame containing the text.
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Cutting, copying and
pasting frames

Three operations you can perform with frames use a clipboard. When you cut
out or copy a frame, the copy or the cut-out frame is added to the clipboard.
Although you can't look at the clipboard itself, you can paste whatever is on it
elsewhere in the same document, or into a different document, or you can
discard it. There are also clipboards to store text and pictures. You can only
store one thing at a time on each. Whenever you cut or copy a frame, anything
already on the frame clipboard is deleted.
T o copy a frame, select it, then click on Copy frame in the Frame menu. A
copy of the frame and its contents is placed on the clipboard, allowing you to
paste the copy in elsewhere or into a different document.
To cut a frame, make sure it is selected, then click on Cut frame in the Frame
menu. The cut-out frame is stored on the clipboard.

-

To paste a frame into a document, click on Paste frame in the Frame menu.
The contents of the clipboard are pasted onto the current page of the document

Working with stories

Once you have drawn frames, you can add text and graphics to your document.
You can import text you have prepared using an editor or word processor, or
you can type text directly into your document. To import text, work in frame
mode. This section describes how to import stories and pour them into frames,
and how to rename and delete stories.
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Preparing text for
importing

You can import text, or stories, from Edit, 1st Word Plus or from any other
editor or word processing program which allows you to save text in ASCII
format. There are some guidelines you should follow when typing your source
text, to make the transfer as smooth as possible.
• A paragraph break is best signalled with two Returns. A single Return
will be ignored and the text will all be formatted into one block. For this
reason, don't use double line spacing except where you want a new
paragraph.
• Multiple blank spaces will all be reduced to single spaces.
• Tabs will be preserved, but the original alignments will not be retained.
• Type styles such as bold and italic may be lost (they will be preserved if
you use 1st Word Plus, as described below).
• Automatic hyphenation should be turned off if your word processor allows
you to do so. Automatic hyphens inserted when the text is prepared will
become fixed hyphens when brought into Acom Desktop Publisher, even if
the word is no longer at the end of a line.
• Characters such as currency symbols, quotation marks, and apostrophes may
not be imported correctly so you should check all text carefully after
importing it.
• Acom Desktop Publisher paragraph styles can be 'flagged' in your source
text, so that they are assigned automatically when you import the text. See
the next section - Flagging paragraph styles in source text - for how to do
this.
• If you prepare your text using Edit, only the basic text itself (plus any
flagged paragraph styles) will be transferred into Acom Desktop
Publisher. If you use 1st Word Plus, more information will be preserved:
-

All text styles can be carried across.

-

Automatic hyphens inserted at line breaks will be recognised and
taken out if appropriate.

-

Line returns inserted using Return will be retained.

-

Footnotes will be retained but may need repositioning.
However:

-

Tabulation will be discarded.

-

Page breaks and printer control codes will be ignored.
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1 Click on the box next to the tint you want, or choose Transparent to give the
frame a transparent background.
2 Click on OK to add the tint to the frame.
You will need to use this option if you have overlapping frames and want the
contents of the frame behind to show through. The example oppos ite
illustrates this: the acorn lies in one frame behind the larger transparent
frame containing the text.

-

Double line spacing will revert to single line spacing.

No matter which word processor you used to create the original story, the
original file is not altered in any way when you copy it into Acom Desktop
Publisher.

Flagging paragraph
styles in source text

You can flag paragraphs in your source text by including the style name at
the beginning of the first line of the paragraph, enclosed within angle
brackets. Acom Desktop Publisher will then give the text that follows the
corresponding style. The source text on the left, below, would generate the
text in the frame on the right:
<headline>This is the headline

<subhead>This is the subhead

This is some body text

This is
the
headline
This is the
subhead
This is some body text

Note the following:
• Body text should be left untagged.
• Each new paragraph should be preceded by two Returns.
• Style names should not contain spaces: the style name 'body text' does not
cause a problem, however, since all untagged paragraphs will be given the
body text style.

---,

• If you tag a paragraph with a style name that Acom Desktop Publisher

-

does not recognise, it will be tagged with a paragraph style having the
name you have given it, with the properties of body text. You can then edit
your new style to give it the properties you want.

Importing a story

Follow these steps to import the story into your document:
1 Switch

-

to

frame mode.

2 Open a window for the directory containing the story you wish to import.
3 Drag the icon for the story to the document or browser window. The name
of the story appears in the browser.

Pouring a story into
frames

If you select a frame before importing the story, the story will flow directly
into that frame until either all the story has appeared or the frame is full.
If you do not select a frame before importing a story, the name of the
appears in the browser showing that it has been imported and can be
later. When you are ready to use the story, click on a frame to select it,
click on the story name in the browser to pour as much of the story into
the frame will hold.

story
used
then
it as

Often, your story will be too long to fit into a single frame. A frame will
have a dotted bottom edge if the story is too long to fit into it and there is
some text still unplaced. To place the rest of the text in frames, select the
next frame and click on the story name in the browser. The next part of the
story will flow into the frame, either until it has all appeared or until the
frame is full. Repeat this procedure as many times as necessary.

Adding a page

When all the frames on the first page are full, you will need to create
another page. You can add a new page before the current page or after it:
• To add another page after the current page, use Add page in the Page menu.
• To add another page before the current page, use Insert page in the Page
menu.

If the last page of the document is on the screen, you can add a new page by
clicking on the right arrow of the page icon.
A new page will always use the layout design of the master page.

If you add a page in the middle of your document when using different left
and right pages, all pages following the new page will change sides lefthand pages will become righthand pages and vice versa - and the frames
may no longer be correctly aligned with the margins.

Deleting a page

To delete a whole page, display the page and then click on
the Page menu. All subsequent pages will be renumbered,
using different left and right pages, all following pages will
left pages will become right pages and vice versa - and the
longer be correctly aligned with the margins.

Delete
but if
change
frames

page in
you are
sides may no

Frames, stories and
pages

Stories flow into frames in page order. If you have already used frames on
Pages 1 and 3 and then decide to use a frame on Page 2, the text on Page 3
will move over into the newly selected frame on Page 2 when you click on the
story name in the browser. More text will flow in to replace the contents of
the frames on Page 3. In this way the story will always retain a logical order
within the document.
Where several frames contammg the same story appear on the same page,
text will flow into them in the order in which you created them, no matter
where they are placed on the page.

-

If an existing frame is resized, the text will be reformatted to fit the new size.
The text in subsequent frames will also be adjusted so that it follows on
correctly.

-

Displaying information
about a story

You can inspect information about the length of a story, how much of it
currently occupies frames, and how much of it remains to be placed, by
double-clicking Select or Adjust on the name of the story in the browser. The
Statistics dialogue box that appears also tells you how much unused frame
there is and how much memory is available to Acom Desktop Publisher:

Statistics
Exafllple
Statistics for:
Size <Kbytes)
38
Nufllber of pages
1
Total nufllber of words
1278
Nufllber of words placed
1256
Nufllber of words refllaining
14
Unused fraflle Cinches)
8
Free RAM <Kbytes>
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Renaming a story

OK

I

A story does not have to keep the name it h ad when you imported it. To
rename a story, follow these steps:
1 In frame mode, select a frame containing the story or click on the story
name in .the browser. The story name in the browser is highlighted.
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2 Display the menus and click on Rename story in the Imports menu. A
dialogue box appears:

Rena111e stor11
Old na111e
Hew na111e

I

OK

Hews!
!Good Eews

I

I

Icancel I

3 Type a new name for the story and click on OK. The browser displays the
new story name.

Deleting a story

To delete an unwanted story from your document:
Click on the story name in the browser or select a frame containing the
story. The story name is highlighted.
2 Click on Delete story in th e Imports menu. A dialogue box appears, giving
you the chance to cancel the instruction.
3 To confirm the deletion, click on OK and the story is removed from the
document and the browser. Any frames that held material from the
deleted story are emptied.

Repelling text

58

When a frame is superimposed on another frame which contains text, the text
in the frame underneath may be hidden. You can reveal the text by making
the top frame repel the text in the underlying frame. The text will then be
'pushed aside' by the top frame so that it always remains visible. To set this
option, click on Repel text in the Frame menu. The Repel text dialogue box
appears, allowing you to turn the facility off or on. When R epel text is
turned off, any text which lies behind a frame with an opaque tint will be
hidden from view.

Working on your document

-

The same dialogue box allows you to specify the amount of space to be left
around each frame:

RePel text
padding: inches
Uertical space /e.1n
Horizontal space /8.17
[EBRepel text this fra~e
Fra~e

I
Typing and styling
text

OK

I

/Cancel/

Once you have imported a story, you can add to it, edit it, choose text styles
and add graphics. You can type in new text, either adding it to an existing
document or typing straight into a new document.
You need to work in text mode to type in, edit and style text.

-

The character sets

Acom Desktop Publisher uses the default RISC OS character set, which is the
ISO Latinl Alphabet. The table of characters is given in Appendix C.
Foreign keyboards will have accented characters. If your keyboard h as
accented characters, Acom Desktop Publisher will show them on the screen as
you type them.

If you do not have a foreign keyboard, you can obtain an accented character
using the Alt key in combination with the ASCII number of th e character you
want, typed on the numeric keypad. Use the table in Appendix C to find the
ASCII number.

-

-

There is another range of characters you can use either as the introductory
symbol of a bu llet paragraph, or elsewhere within the text. T o use one of
these characters in a block of text, use the Font/size option in the Text style
menu and choose a symbol font such as Selwyn. Then refer to the second
character table in Appendix C to determine the ASCII number of the
character you want. To make the character appear in your text, hold down the
Alt key while typing the ASCII number on the numeric keypad.
To use bullets to introduce specially formatted paragraphs, you need to set
up a paragraph style with a bullet using paragraph mode. This is described
under Bullets in the chapter Giving your docun;ent a style.
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Typing in text

You may sometimes want to type a short piece directly into your Acom
Desktop Publisher document. It is quite possible to type in longer articles,
but it is usually more efficient to use a word processor and then import the
text. You can also amend imported text.
To type in some text:
Click on the text icon in the toolkit to switch to text mode. The pointer
changes to a caret.
2 Click in the frame at the point where you wish to add some text. Another
caret appears; this one does not move when you move the mouse, but
indicates where the new text will appear.
3 You can now type in text until the frame is full.
Text that is typed directly into your document can be edited in the same way
as imported text. To move around the text, use either the arrow keys or the
pointer. Click Select to move the caret to the pointer position. The chapter
Keystroke equivalents lists all the keystrokes you can use instead of the mouse
and the menus, when you are entering or editing text.

If you type in more text than will fit into the frame, the caret will disappear.
Any text you type after the caret has disappeared will not be recorded.
Resize the frame or delete some text to restore the caret to view.
Styling text

You can style your text by using different fonts, such as Homerton or Corpus,
different type styles, such as bold or italic text, and different point sizes.
Apart from the point sizes displayed, you can choose your own custom point
size.
You can choose a text style from the Text style menu or the browser, or you
can use one of the function keys to access styles.
The style options you are currently using are marked with a tick in the Text
style menu and shown in reverse video in the browser.
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bold ____.

underlined____.

With Acorn Desktop Publisher,+------ italic
you can use your computer
screen to lay out pages of words
and pictures. Put in headlines,
adjust the size of illustrations,
choose different typestyles, move
items from, place to place; Acorn
Desktop Publisher gives you
complete controP over the appearance of the prifted page.
superscript

If you choose a new style option while the caret is in the text, text typed in
from that point will be in the newly chosen style. If you move the caret to
another position, the next text typed in will take on the style features of
surrounding text.
The text style options in the Text style menu and the browser can be toggled
on and off. This means that you use the same action to turn them on as to turn
them off: click once on a style attribute to turn it on, and click aga in to turn it
off. The Text style menu also offers a Normal style option which will turn
off all the other attributes.
You can alter the style of a block of text after you have typed it. This is
described in the section Restyling a block of text later in this chapter.

Editing text

-

There are several types of ed iting operation you can perform. You can:
• search for a character or string of characters and replace it with another
• override the automatic hyphenation to add hyphens where you want them
• override the automatic spacing to keep a fixed space between two words
• restyle text

\Al--1,:--
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• delete text
• move text
• copy text.
You need to mark a block of text before you can use the last fo ur operations.
This is explained later in this chapter.

Find and replace editing

If you want to search for a word or phrase in a story, use the Find option in
the Text edit menu. The program starts searching from the caret position and
searches through to the end of the story. You can choose whether you want
Acorn Desktop Publisher to ignore or match the case of the text.

Find
Find

lso111e words/
1§1 Case sensitive
-0-K-1
lcancell

When the program finds a matching string, it marks it as a block, displaying
it in reverse video.

If you want to replace one word or phrase with another throughout your story,
select Replace from the Text edit menu. This allows you to specify both the
string to be replaced and the new string. You can also choose whether you
want to be asked to confirm the change each time a string is found (click on
Some for this option) or for all the changes to be made without confirmation.

Replace
Rep lace <$> One <) So111e <)A 11
of

with

If
I

I
I

[]Case sensitive
........O...
K...,
ICancell
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You can search for the next instance of the string using Repeat find in the
Text edit menu. Most of the actions have keystroke equivalents, listed in a
later chapter.
You can use Find, Replace, and Repeat find only in text mode.

Soft hyphens

-

Acorn Desktop Publisher follows hyphenation rules which control how long
words are broken over line divisions. If you want to change the way a word
breaks over a line division, you can override the rules by inserting a soft
hyphen where you would prefer a word to be hyphenated. If the word does
not need to be broken, the hyphen will not be used, but if the word does fall
over a line division it will be split at the position of the soft hyphen.
To insert a soft hyphen place the text cursor where you want the word to
break and choose Soft hyphen from the Text edit menu:

If you want to prevent a particular word from being split at all, place a soft
hyphen in front of its first letter. The whole word will then be carried over to
the next line.
Acom Desktop Publisher provides a Hyphenation Exception Dictionary which
lists words that are exceptions to the normal hyphenation rules or which are
never to be hyphenated. You can edit this list directly as long as you observe
a few basic rules. Appendix D explains how to do this.

Fixed spaces

When you are using justified text, Acorn Desktop Publisher varies the size of
spaces between the words on a line to fit the line between the margins.
Sometimes you might want to keep a fixed space between two words such as:
• initials and names: 'W S Churchill'
• telephone numbers: '01-200 0200'
• addresses: '5 Palm Grove Avenue'
• trademarks: 'Acorn Desktop Publisher'
You can insert a fixed space between words to preserve the spacing. The
words will not be split over a line break and the space between them will not
be 'stretched' during justification. To add a fixed space, use Fixed space in
the Text edit menu.

Kerning

Kerning is a printer's term for adjusting the spacing between letters on a line.
Because of their shape, some letters can look unbalanced when evenly spaced.
This is especially noticeable when characters which have sloping sides are set
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in large upper-case letters. An example is the word 'A WAY'. You may wish
to move the letters of the word 'AW A Y' closer together. You can do this by
using the Kern option in the Text edit menu:
1 Place the caret between the letters you wish to kern.
2 Select the Kern option. A dialogue box appears, allowing you to set the
amount of extra kerning you want:

Kern two characters
points
Di re ct ion [!][!J][J

I

OK

I

-

ICancel I

The measurement is in points. The symbol in the small box to the left of
the measurement represents the direction of the kerning, + to increase the
space, - to decrease it. To switch between these, click on the box.
3 Click on OK when you have chosen the value and direction of the kern.
You can also reduce the space between letters by pressing Ctrl-K. Each time
you press this key combination, the kerning reduces by a small amount. Press
the keys as many times as necessary to obtain the spacing you want. If you
make the space too small, use the menu option to increase it again.

Marking a block of text

You need to mark a block of text before you can move it, delete it, copy it, or
restyle it. To do this:
1 Move the caret to the start of the block you want to mark.
2 Press Select and drag the caret to the other end of the block. The marked
block will be highlighted.

If you want to mark a single word, you can do so quickly by double-clicking
on any part of it. The word and the space following it will be marked as a
block.
Restyling a block of
text
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You can alter the style of a block of text in much the same way that you set
the style when inserting new text. Once you have marked the block, you can
use the Text style menu, the browser or the keystroke alternatives to choose a
style or combination of styles for the block. For example, to change a block
of text to bold type:
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Mark the block you want to change.
2 Choose Bold text from the Text style menu or browser.
You can also change the font and point size of a block:
1 Mark the block you want to change.
2 Click on Font/size in the Text style menu to display the Font and size
dialogue box:

Font and size
Size:

Font:
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3 Choose the options you want and click on OK The marked block takes on
the characteristics you have chosen.

If you make the point size so large that not even the first character will fit into
the frame, your frame will appear to be empty, but you won't be able to add
anything to it. To make the text reappear, you will have to enlarge the frame
until at least one character will fit into it.
You can also change the text style of a whole paragraph. This is described in
the chapter Giving your document a style.

Cutting, copying and
pasting a block of text

You can cut out or copy a block of marked text and store it on the text
clipboard, by clicking on Cut text in the Text edit menu.
To copy a block of marked text onto the clipboard without deleting it from
the document, click on Copy text in the Text edit menu.
Each time a block of text is cut or copied to the clipboard it replaces any text
which is already there, but does not affect the frame and graphics clipboards.
To paste text from the clipboard into a document, position the text cursor
where you want to add the text click on Paste text in the Text edit menu.

Working with pictures

You can add pictures to your document either by importing pictures you have
prepared with a drawing or painting program like Draw or Paint (part of the
Applications Suite supplied with your computer) or by using Acom Desktop
Publisher's drawing tools. This section explains how to import, crop and
delete pictures prepared with a drawing or painting program.

Line art files and image
files

There are two types of picture you can import into your document. A drawing
program such as Draw will produce a line art file, while a painting program
like Paint will produce an image file.

Importing a picture

Follow these steps to import a picture into your document:
Switch to frame mode.

2 Open a window for the directory containing the picture you wish to import.
3 Drag the icon of the picture you want to import to the document window or
control panel. The name of the picture appears in the browser.

If you import a sprite file created in Paint, all the sprites within it will
appear in the browser.

Adding a picture to a
frame

If you select a frame before importing a picture, the picture will appear in
the frame immediately. If you do not select a frame, the picture's name is
added to the browser for you to use later. When you are ready to use the
picture, select a frame and then click on the picture name. The picture will
appear in the selected frame.
Once a picture is listed in the browser, you can use it again in as many

different frames, and on as many different pages as you like. Every time you
want to add the picture to the document, select a frame and then click on the
picture name.
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Deleting a picture

If you accidentally load the wrong picture, you can remove it from the
document:
1 Select the picture by selecting the frame containing it, or by clicking on its
name in the browser.

2 Select Delete drawing or Delete image in the Imports menu. A dialogue
box appears, allowing you to delete the picture by clicking on Delete. You
can change your mind about deleting a picture by clicking on Cancel.

If you have already loaded the picture into one or more frames it will be
removed from them.

If you have imported the picture into more than one frame and wish to delete
it from only one, either import a different picture of the same format into that
frame, or delete the frame and redraw it.

Renaming a picture

You do not need to keep the name the picture had when you imported it. To
rename a picture:
Switch to frame mode and select a frame containing the picture. The picture
name in the browser is highlighted in reverse video.

2 Select Rename image (or Rename drawing) in the Imports menu. A
dialogue box appears:

Renaflle drawing
DrawColufllb
IDrawColufllbll

Old naflle
New naflle
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OK
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3 Type a new name for the picture and click on OK. The browser displays
the new picture name.

Hiding the pictures

If you want to increase the speed at which the screen is redrawn, you can tum
the pictures off. This does not remove the pictures from the document, but
hides them until you tum them back on. To tum the pictures off, click on Show
pictures in the View menu . All pictures are replaced by a box containing a
diagonal cross.
To tum the pictures back on, click on Show pictures again. The Show pictures
option is ticked when the pictures are turned on.
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Cropping a picture

You can cut away parts of a picture and later restore them. To crop a picture:
1 In frame mode, select the frame for the picture you want to crop.
2 Select Crop picture in the Imports menu. The pointer changes to a pair of
scissors.
3 Use Select or Adjust to drag a box inside the picture to mark the portion
you want to keep. When you release the button, the part of the picture
inside the box expands to fill the whole frame.

-

-+

4 When you have finished cropping the picture, click Select anywhere within
the document window or control panel.
You may crop the picture as often as you like. Cropping does not maintain the
original proportions of the picture, so the cropped portion may appear
stretched.
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You can restore cropped parts of the picture by dragging a box outside the
cropped picture, but within the document window:

-+

Cropp ing does not affect the original picture. You can restore it by selecting
the frame and clicking on the picture name in the browser.

Drawing graphics

-

As well as importing pictures, you can create simple line drawings in your
document using the drawing tools. You should prepare any complex drawings
with a drawing program and then import them, but you can add to them with
Acom Desktop Publisher.
T o draw in your document, switch to graphics mode. The browser is replaced
by the drawing tools. When you first enter graphics mode, the selected tool is
an arrow shape: use this once you have drawn a line or a shape, to select it for
editing. When you select this tool, the pointer also changes shape to a large
arrow.
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Using the drawing
tools

You can either draw in an empty frame, or you can add graph ics to a frame
with text or a picture in it:

.......

1 Switch to graphics mode.
2 Select a frame. The frame is displayed with the grid shown in faint dotted
lines:

-

3 Choose the drawing tool you want by clicking on its icon in the browser.
You can draw:
• straight or freehand lines
• polylines (for example, zigzag lines)
• a variety of shapes such as squares, circles, or ellipses.
You can also choose the line and fill styles, and when you have drawn some
graphics you can edit and rearrange them.

Drawing lines

l2l

To draw a straight line:
Click ori. the straight line icon; it is highlighted in reverse video.
2 Press and hold down Select at the point in the frame where you want the
line to begin.
3 Drag across to the point where you want the line to end and release Select.
A straight line is drawn joining the two points. It has handles which you can
use to change it:

0----------------~o
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fTo draw a freehand line:
Click on the freehand line icon.
2 Press and hold down Select at the point in the frame where you want the
line to begin.
3 Drag the pointer along the path you want the line to follow and release
Select when you reach the line end:

The amount of memory allocated to each freehand line is limited. When your
line exceeds the memory limit, the drawing tool will temporarily stop
working. To continue drawing, deselect the line you have drawn by clicking
outside its handles (but within the frame it lies in), then continue drawing a
new line from the point where the first line finished.

Drawing a polyline

To draw a polyline:
1 Click on the polyline icon in the browser. The polyline icon is highlighted.
2 Press Select at the point in the frame where you wish the line to start.
Holding down Select, drag to the first angle of the line, and, still holding
down Select, click with Adjust to mark an angle and change the direction of
your polyline.
3 Click with Adjust at each subsequent angle until the line is complete.
4 Release Select to stop drawing.

-
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Drawing shapes

§§
LQl§J

You can also draw shapes such as circles, ellipses or rectangles in a similar way:
1 Choose the icon for the tool you want.
2 Press and hold down Select at the point in the frame where you want to
position one corner or edge of the shape, drag across to the opposite edge
and release Select.

DD

.oo

-

You may want to add some text to a picture. If you expect that you will
always want to treat the picture and the text in the same way (labels on a
graph, for instance), add the text directly to the frame containing the picture.
However, if you think you might want to treat them separately (for example,
scaling the picture but not the text), put the text in a separate frame and
superimpose the text frame on the picture.

Selecting a graphics
object

-

Once you have drawn a graphics object, you may want to edit or delete it. T o
do this, select the arrow-shaped tool in the graphics toolbox. Move the pointer
to the object you wish to change, and click Select. Handles appear, indicating
that the object is now selected. You can use these handles - in a similar way
to the handles on a frame - to resize, move or otherwise change an object.
For details, see the section Moving and resizing objects, later in this chapter.
To select a graphics object that is inside another, first select the outer object.
Then call up the Graphics menu and choose Send to back. This will leave the
inner object at the front, and you will be able to select it. If you have several
'nested' objects, you will need to send each of them to the back in turn in
order to select the innermost one.
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The graphics objects in a frame will be 'stacked' in the order in which you
drew them, with more recently drawn objects in front of less recently drawn
objects.

Changing the line and
fill style

You can choose between several thicknesses and styles of line in black or
white, with arrowheads at one or both ends. Use the Line style option in the
Graphics menu to choose a line style. The line style you choose will be used
to draw the edges of shapes as well as lines, but arrowheads will only be
used on lines.

Line
Ink:
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You can also choose a tint to fill the shapes you draw. C lick on Fill style in
the Graphics menu to display the Fill style dialogue box. There are seven
opaque background tints, from white, through six levels of grey, to black.
There is also a transparent tint which allows objects behind the shape to be
seen. This dialogue box also allows you to choose whether or not the edge (or
perimeter) of a shape will be drawn in. Make your selections by clicking in
the appropriate boxes.

Fill shle
<)Transparent

<t> Do•

-

ooo•
ooo•
ooo•
lili] Periflleter

I

OK
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The Fill styles option is available fo r any shapes you draw with the shape
tools, but you cannot fill a shape that you drew using the straight line,
free hand line, or polyline drawing tools.
You can either set up line and fill styles before draw ing your shapes, or
change the line and fill style of objects you have already drawn. If you set up
sty les in advance, any item you go on to draw uses these styles. lf you change
the line or fill style selections while an object is selected, the new style
selections will be applied to the selected obj ect and to any more you draw.

Moving and resizing
objects

It is easy to move an object or adjust its size or shape after you have drawn it.
To move an object:
Select the object.

2 Hold down Select.
3 When th e grabber hand appears, drag the object to its new position .
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You cannot drag an object outside its frame, nor from one frame to another. If
you want to move an object to another frame, use the cut and paste facilities in
the Graphics menu.
To change the size or shape of an object, select it and use the Select button to
drag the frame by the handle until it is the size and shape you want. Dragging
on the handles produces different effects according to the type of object
being manipulated:
• When working with a line, drag a handle towards or away from the other
handle to shorten or lengthen the line. As you drag the handle , the line
pivots around the other handle.
• When working with a circle, drag a handle towards or away from the handle
opposite it to make the circle smaller or bigger. As you drag the handle, the
circle pivots around this oppos ite handle.

-

• When dragging the handle of all other objects, drag a comer handle to
lengthen or shorten th e object both vertically and horizontally, or drag a
centre handle to lengthen or shorten the object either vertically or
horizontally.
You can move and resize objects with greater accuracy using the Size and
position option in the Graphics menu:
Select the object you wish to move or resize by clicking on it.
2 Click on Size and position in the Graphics menu. The Size and position
dialogue box appears:

---.,

Size and Position
inches
Dilllensions
Horizontal position L[ffi]
[!!]
Uertical position
Width
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Height
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-

-

3 T o move the obj ect, change the Horizontal pos1t10n and Vertical pos1t10n
entries. The Horizontal position is the distance between the lefthand edge
of the object and the lefthand edge of the frame it was drawn in. The
Vertical position is the distance between the top of the object and the top
of the frame it was drawn in.
4 T o resize the object, ch ange the Width and Height entries.

-

5 · C lick on OK to apply the changes to the obj ect.
You can also check the size and position of an obj ect by double-clicking on
the obj ect.

Cutting, copying and
pasting objects

You can cut, copy and paste graphic objects in the same way as you can with
text and frames. Select the item you want to cut or copy and use:

-

• Cut item in the Graphics menu to cut an obj ect
• Copy item in the Graphics menu to copy an obj ect.

The copy or cut out object is stored on the graphics clipboard . If you want to
paste the obj ect into the same frame or a different frame, select the frame
and use the Paste item option in the Graphics menu .

--

Remember that only one item can be held on each clipboard . When you use a
Copy or Cut option , the new item is added to the graphics clipboard and
anything which was already held on it is lost.

-
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Givin g your docum ent a style

This chapter shows you how to give all your documents a consistent and
professional look. It shows you how to use a style sheet, set up your page
format and create paragraph styles.

-

Using a style sheet

Every document you create with Acorn Desktop Publisher is formatted using a

style sheet. A style sheet is a file which stores information about the stylistic
features of your document. You cannot look at the style sheet directly, but you
can examine the information it stores:
• the page format you have chosen

-

• the design of the master page
• the paragraph styles you have designed.
Because all this information is stored together in a named file you can re-use
the same format in several documents. All the documents you create using the
same style sheet will have the same appearance, so it is easy to make your
documents look consistent.

If you wish to use an existing style sheet when you open a new document,
follow these steps:
1 Open a window for the drive and directory containing the style sheet.

-

--

2 Double-click on the style sheet icon. If the program is not loaded 1 it loads
automatically and the Acorn Desktop Publisher window opens.

If the program is already loaded, you can also drag the style sheet icon to the
Acorn Desktop Publisher icon in the icon bar.
If you choose an existing style sheet, you will not need to set up the page
format, master page and paragraph styles. You can modify the master page
and add paragraph styles to those on the style sheet, but you cannot alter the
page fo rmat once this has been set. If you do not choose to use an existing
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style sheet, you will need to set your page format and design a master page
before you add any text or graphics to the document. You can create
paragraph styles as you go along - you don't need to set these up at the start.

Setting up your page
format

The page format controls the paper size, orientation of the paper, and whether
your document is laid out and printed with different left and right pages, or
with all the pages the same. It is important to set your page format correctly
before you start work on your document, as you cannot change it later.
To set up your page format:
Press Menu on the icon bar icon for Acorn Desktop Publisher.
2 Select Page format from the DTP menu.
3 Choose your paper size, its orientation , and whether you want the pages in
your document all the same or different lefthand and righthand pages, by
clicking on the relevant boxes. The illustration shows you the default page
format settings. These are the settings you will get if you do not make any
changes.

Page f or111at
Page size:
218 x 297 fllfll
<$> A4
<)Letter
8.5 x 11.8 in
<)Legal
8.5 x 14.8 in
5.5 x 8.5 in
<)Note
<)User
mJ] x [ill]~
Orientation : Master pages:
<$> Portrait <$> All alike
<)Landscape <)Left & right

I
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ICancel I
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Paper size

The Page format dialogue box offers you four standard paper sizes:
• A4=210x297m m
• letter = 8.5 x 11 inches
• legal = 8.5 x 14 inches
• note = 5.5 x 8.5 inches.
Alternatively, you can define your own paper size. To select the unit you want
to use, click on the box showing the units.

Different left and right
pages

If you are going to print your document on only one side of the paper, choose

Page orientation

Choose Portrait to make all the pages in your document tall, and Landscape
to make them wide:

-

All alike to create a single master page. Every page in your document will
then have the inside or binding margin on the lefthand side. If you want to print
your document on both sides of the paper, choose Left and right. The binding
margin will then be on the left for each righthand page, and on the right for
each lefthand page.

Portrait

The master page

Landscape

If you want a document to look really professional, you should try to use the
same basic layout on every page. To do this, create a master page which will be
used as a template for every new page you create. On the master page you can
draw column guides to help you align frames for text and graphics, draw
frames, and include any graphics (such as a logo) that you want to appear on
every page. You can have two master pages, one for lefthand pages and one
for righthand pages; this is appropriate if your document is to be printed on
both sides of the paper.
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Displaying the master
page

To display the master page of your document, first click on Go to page in the
Page menu. Then:
• if you have chosen All alike on the Page format dialogue box, just click on
the box
• if you have chosen Left and right on the Page format dialogue box, click on
the L or the R .
You may need to sw itch to Full page view in the View menu if all of the
master page is not visible. If you h ave chosen Left and right master pages,
you can display both master pages together by clicking on Double page in the
View menu. If you look at only one of the master pages, the folded-down
comer on the page icon will show you whether you have a left or right page on
screen.

Designing the master
page

The master page acts as a template for any new pages you insert into your
document. When you start a new document, the first page will change
automatically when you first design the righthand (or only) master page,
unless you have already drawn frames on the first page. Any further pages
you add will h ave the same layout as the master page(s). You can change the
master page after you have added more pages without affecting the existing
pages, but any new pages you add will have the design of the new master
page.
When you have finished designing your master page(s) use the Go to page
command in the Page menu to display the first page of your document. To do
this, you don't need to type a page number, as the first page is automatically
displayed if you click on OK

Paragraph styles
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A paragraph is any block of text which ends with a Return. It can be of any
length, from a single character to a full page. In Acom Desktop Publisher,
each paragraph is tagged with a style name; a style is assigned to a paragraph
by choosing the Paragraph option from the main menu. The section Working
with paragraph styles later in this chapter explains how to assign paragraph
styles; in the rest of this section the basic concepts are explained. The style
attributes of a paragraph are used for all paragraphs with the same style
name. Paragraph styles you might use in your documents include body text (for
the bulk of your text), subheading, heading, and bullet (for lists). A new
paragraph is always tagged as body text until you give it a different style
name.

Giving your document a style

-

-

-

A paragraph style sets these features of text:

......,

• text style
• leading
• justification
• hyphenation

-

• bullets
• letter spacing
• indents and margins
• word spacing

-

• tab settings
• font
• point size.

-

You can set each of these when you create a new paragraph style or edit an
existing style. It is important that you know what each of these is before you
start to use the paragraph style editing commands.

Text style

There is a variety of text styles, including:
• bold
• italic
• underlined
• superscript
• subscript
• normal.
Some of these styles can be combined with others. For example, you could
have underlined bold text.

Leading

-

Leading is the space between lines. It is called lead ing because printers
originally used strips of lead to separate the lines of type (and is thus
pronounced 'ledding'). Leading is measured in points (a point is 1/72 of an
inch). You can alter the leading to create the appearance of single, double, or

other types of line spacing, though there is a minimum leading which depends
on the font size selected.
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Text format

-

There are five text formats you can choose from:
• fully justified (like the main text paragraphs in this Guide)
• flush left
• flush right
• centred

-

• tabulated.

Hyphenation

Bullets

Acorn Desktop Publisher will automatically hyphenate words which fall over
line breaks if you are using fully justified text. You can turn hyphenation on
or off, and control the point at which a word breaks (see Soft hyphens in the
chapter Working on your document). If you want to use hyphenation, you can set
the hyphenation hot zone. If a long word comes at the end of a line and crosses
into the hyphenation hot zone it will be split and hyphenated. The hyphen
will fall within the hot zone.
You may wish to have a bullet as the first item in a paragraph. This is
particularly suitable for lists or instructions which need not occur in an
ordered sequence. There are several designs of bullet:

A bullet will always appear as the first character on the first line of the
paragraph, and only on that line. If you want a bullet elsewhere, you will
have to type it in individually. The section The character sets in the chapter
Working on your document explains how to do this.

Word spacing

If you are using justified text, the program will rdd extra space between
words to fit each line between the margins. You can set the maximum and
minimum space between the words in each paragraph style. The space
between words is measured in ems.

Letter spacing

If the amount of space which would need to be inserted between each word to
justify the text exceeds the maximum you have set, extra space is added
between the letters in each word. You can prevent extra space being added
between the letters, as described under Creating a new paragraph style, below.
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Paragraph indents and
margins

You can set the space above a paragraph, and the amount by which the
paragraph is to be indented from the left and from the right. The left indent
of the first line is set separately from that of the remaining lines.
The left and right margins are measured from the left and right edges of the
frame. The top of a paragraph will start at the top of a frame if it is the first
paragraph in the frame.

-

You can create a hanging indent by indenting the first line less than the other
lines in the paragraph. This is useful for numbered paragraphs in which the
text is in a block and the numbers are set out to the left (like the numbered
lists of instructions in this Guide). Type the number of the paragraph on the
first line and press Tab to move the cursor to the indent position. Continue
typing and the rest of the paragraph is automatically indented. Start a new
paragraph for each numbered point.

Tabs

You can set up to ten tab stops in a paragraph. For each one you can choose:
• the type of tab stop it is (left, centre, right, or decimal)
• the position of the tab stop
• the leader character to be used (spaces, dots, underlines)
• the amount of space to insert between each leader character.
Tab positions are set from the left of the frame.

Font and point size

You can choose the font and point size you want to use in a paragraph. The
larger the point sizes you choose, the larger the letters will be: 8 is a very
small point size, 32 is the largest you are likely to use. This Guide is set in 10
point, with the chapter headings in 24 point.

Adding headers and
footers

You can add header and footer lines to your document at any time. To create
a header or footer:
Select Headers and footers in the Page menu. The Headers and footers
dialogue box appears.
2 Choose whether you wish to create a header or a footer by clicking in the
appropriate box.
3 Choose whether you want the header or footer to appear only on the
lefthand or righthand pages or on every page, again by clicking in the
appropriate box. If you have chosen to have all pages the same, this will
mean that the same header and footer will appear on each page.

-
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Headers and Footers
Type:
Page:
inches
~
%Header c=] Left Distance froM top of page
<)Footer c=] Right Start nuMbering froM page [!:][!][!]
§]All
Text (use It for page no)
Left IDoc1Interna l!ABC11. 5h
I
Centre I- It I
:::::=====================================~
Right 11513189
I

1--0-K4 Set how far from the top of the page you wish a header to be placed, or
how far from the bottom of the page you want a footer to appear. T ype the
number you want to appear on the first page in the box Start numbering
from page. The page number will be printed on each page, starting with
this number.
5 Type any text you wish to appear on the
or footer in the appropriate box. If you
appear in this text, use #. For example,
the foot of page 1, 'Page 2' at the foot of
the footer box.

left, centre, or right of the header
want the current page number to
if you want 'Page 1' to appear at
page 2, and so on, type 'Page#' in

6 Click on OK when you have finished.
When you have defined a header or footer, a new style - Header or Footer appears in the browser, allowing you to change its appearance.

Working with
paragraph styles
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To work with paragraph styles, you need to be in paragraph mode . The
paragraph styles which are currently available will be shown in the browser
when you are using paragraph mode. The commands you need to use to work
with paragraph styles are in the Paragraph menu .
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When you first import or type a story, all the paragraphs will be tagged as
body text (unless you have flagged them in the source text, as described in the
section F1.agging paragraph styles in source text in the previous chapter). When
you want to create paragraph styles and allocate styles to paragraphs, first
select the paragraph you want to work on, by moving the pointer onto a
paragraph and pressing Select: the whole paragraph is highlighted and the
name of the paragraph style is highlighted in the browser. If you want to
select a paragraph style rather than a single paragraph, click on the name of
the paragraph style in the browser.
This section explains how you can:
• create a new paragraph style
• edit an existing paragraph style
• rename a paragraph style
• tag a paragraph with a different style
• delete a paragraph style.

Creating a new
paragraph style

To create a new paragraph style, begin with an existing style and alter the
settings, then give the new style a new name . This does not affect the existing
style at all. To create a new paragraph style:
1 Select a paragraph of text which has the style closest to the one you want to
create.
2 Click on New style in the Paragraph menu. The dialogue box that appears
shows the name of the style you have selected and has a box for you to give
a name for the new style.
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3 Press Esc to clear the name box, then type a name for the new style and
click on OK. The Paragraph style dialogue box appears:

Para ra h

Font size and st le
Font:
Size: Style:
8 Oaold
19 D Underline
newhall
<)12 Ortalic
trinity
Ought
18 D Superscript
(>29 0Subscript
0White

-

BODY TEXT

<>

-

4>

<>14

IDi111ensions I

<>

<>24
<>2a

Options
For111at

____

....__

I OK 11 Cancel

-

I

Custo111 size:

-

-

<'>36

__._..._.
Jj

{ ) 72

[!!]

Leading: [[]

4 This dialogue box has four different righthand sections, each one
corresponding to a small box on the left. The Font, size and style box
always appears first. Choose a font by clicking on its name (you can scroll
this window if necessary). Click on the style boxes to turn each style on or
off. Set the point size by clicking on the diamond-shaped box next to the
. size you want, or by typing any size you like in the Custom size box.
5 If you choose one of the point sizes given, a suitable leading is offered,
which you can change if you wish. If you choose your own point size, you
must also enter your own value for the leading.

-

-

6 You can choose which other features of the style to set by clicking on the
boxes Dimensions, Options and Format. When you click on one of these, a
new section of the dialogue box appears.
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7 C lick on the Dimensions box to set the margins, the spacing between words,
and the hyphenation hot zone.

Difllensions

Paragraph
BODY TEXT

I

Font

inches
Margins :
je. 21]
Space above
First line left indent je.ee
je.ee
Left indent
je.ee
Right indent

I

IHl~1lUliH

I Options I

Spacing:
MinifllUfll word space
MaxifllUfll word space
Hyphenation hot-zone

I For111at I

I

OK

11 Cancel I

e111s

je .3 I
je. 9 I
j5.8 I

8 C lick on the O ptions box to tum hyphenation on or off, to tum variable
spacing between letters on or off, and to choose a bullet character.

0Ptions

Para11raPh
BULLET

I

Font

Bullet character :

Bll~0

I

[!][!][!]@]

IDifllensionsl

@]@]~[!]
[!]@]~@]

uiUM•

-

I

I

Forfllat

OK

I

~Hyphenation

~Letter

I !Cancel!

-·- -•--··---- .1. -

-.1.- . I -

allowed

spacing allowed

07

9 C lick on the Format box to choose a text format and to set tabs. If you want
to set tabs, you must first choose the Table for mat. The chart beneath Table
lets you define up to ten tab stops.

-

Paragraph

For111at
0Flush left 0Justified 0Flush right
BODY TEXT
<$>Table, units:
inches
Ocentre
Font
I
I
tab
tab
leader leader
tab
no.
type position type spacing
Right
9.59 - - 1
e.10:~
ID i 111ens ions I
jll
2
Left
1.991 NOHE l
_
0.001
11.110
1
NOHE
3
0 00 HO Hf
d.00
NOHE
4
Options
I
I
0.00
HONE
5
NOHE
0.00
-0.00 HONE
NOHE
0.00
6
0.00 HONE
0.00
e1.11:u• 78 NOHE
0.00 NOHE
0.00
NOHE
9
NOHE
0.00 NOHE
0.00
OK 11 Cancel I 19
NOHE
0.00 HONE _'·- 0.00

I

-

When you click on the box to the left of 'Table', the grey entries in the
lefthand column of the table change to black. T o set a tab, click in the box
in this column. The entry NONE ch anges to Left, giving a left-aligned tab
stop. C lick again, and it changes to Right; further clicks give, in turn,
centred and decimal-point aligned tab stops. The second column sets the
tab position. The third column - leader type - allows you to choose either
full stops or dashes to fi ll in the empty space between tab positions, and
the fourth column enables you to choose the spacing between these
characters.

10 When you have finished, click on OK.
You can also allocate the new style to a function key so that each time you
want to use the style you just need to press the function key. The procedure is
described in Assigning function keys below.

Changing an existing
paragraph style

"II

-

-

-

You also use the Paragraph style dialogue box to alter an ex isting paragraph
style. There are three ways to call up the dialogue box if you want to edit a
style:
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3 Press Esc to clear the name box, then type a name for the new style and
click on OK. The Paragraph style dialogue box appears:

-

BODY TEXT

<>

IDiMensions I

I Options I
I For Mat I

I
4 This

=
~

OK 11 Cancel I CustoM size:
dialogue

-

Font. size and stqle
Size: Style:
Font:
corpus ~j
8 0Bold
•111T:.T•lililllll
4.>19 0Underline
newha 11
·()12 Ortalic
trinity
<)14 Ought
<)18 0Superscript
(;>29 0Subscript
<>24 0White
<>2s

ParaqraPh

box

has

fou r

-

<)36
(.';· 72

[!][]
different

Leading:~

righthand

sections,

-

each

one

1 Choose the paragraph style in the browser and click on Edit style in the
Paragraph menu.
2 C lick on a paragraph which has been tagged with that style and click on
Edit style in the Paragraph menu.
3 Double-click on the paragraph name in the browser or on a paragraph of
text tagged with that style.
Use the Paragraph style dialogue box to change the style as you want and
then click on OK. All the paragraphs tagged with that style will be updated
to the new style definition.

Assigning function keys

You can use the function keys to call up paragraph styles instead of clicking
on the names of styles in the browser:
Select a paragraph tagged with the style wh ich you want to allocate to a
function key.
2 From the Paragraph menu, choose Function key to display the list of keys.
3 C lick on one of the function keys listed to allocate the paragraph style to it.
If the style is already allocated to a function key, the key is ticked in the
Key list. You can change the allocation by clicking on the name of a

-

different key.
The function key boxes in the control panel are updated when you allocate a
new key or change an allocation.

Changing paragraph
style

You can change the style of a single paragraph by selecting it and tagging it
with a different style:
1 Select a paragraph. The paragraph is highlighted.
2 Click on a paragraph style name in the browser. The paragraph you have
selected takes on the characteristics of that style.
The paragraph will remain selected so that you can try out a range of styles.

If you have allocated paragraph styles to the function keys, you can change the
style of a paragraph by selecting it, or placing the text cursor within a
paragraph in text mode, and pressing a function key. The paragraph will be
tagged with the associated paragraph style. You can click on the function key

boxes in the control panel instead of using the keyboard if you prefer.
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Renaming a paragraph
style

You can rename a paragraph style without changing its definition. T o rename
a style:
Make sure no paragraphs are highlighted.

2 Select a paragraph tagged with the style you want to rename or click on the
paragraph style name in the browser. The paragraph style name in the
browser is highlighted.

3 C lick on Rename style in the Paragraph menu. The Rename style dialogue
box appears:

Rena111e style
Old na111e
Hew na111e

I

OK

BODY TEXT
IHEW BOD~

I

I ICancel I

-

4 T ype a New name for the paragraph style and click on OK. The name of
the paragraph style in the browser changes to the name you have given .

Deleting a paragraph
style

You can delete any paragraph style except body text. When you delete a
style, any paragraphs in that style revert to body text. To delete a paragraph
style:

-

Click on the name of the unwanted paragraph style in the browser, or
select a paragraph tagged with the style.

2 Select Delete style in the Paragraph menu. A dialogue box appears giving
you the chance to change your mind.

3 Click on OK to confirm the deletion . The name of the deleted paragraph
style disappears from the browser.

Restyling part of a
paragraph

90

You can override the paragraph style of an individual section of the text and
give it different characteristics from the rest of that paragraph. Mark the
section you want to change as a block in text mode and use the Font/size
option in the Text style menu to give the block a different text style, font,
point size, etc. This is described more fully in Restyling a block of text in the
chapter Working on your document.
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-

Saving the style
sheet

When you create or edit paragraph styles, you are also altering the
document's style sheet. If you expect to use the styles you have defined in
another document, save the style sheet:
1 Open a window for the directory in which you want to save your style sheet.
2 From the File submenu, use the Save style sheet option to call up a Save
as dialogue box.
3 Follow the standard RISC OS procedure, as outlined in the Welcome Guide
and User Guide supplied with your computer.
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Acorn Desktop Publisher menus

This chapter lists the options available in the Acom Desktop Publisher
menus. There are ten submenus which can be accessed directly from the main
menu:
• File
• View

-

•
•
•
•
•
•

Page
Frame
Imports
Paragraph
Text style
Text edit

• Graphics

• Help.
Using menus

To display the menus, press the Menu button, then use Select or Adjust to
choose the menu option you want. If you use Select, the menu disappears from
the screen when the action is carried out, but if you use Adjust, the menu
remains on screen (provided the option does not call up a dialogue box).

If an option is currently not available it appears in grey text and you cannot
choose it. It will be available at some other time: in a different mode, for
example.
Many menu options represent features that can be turned either on or off:
when they are on, the option has a tick to its left.
The letters next to some of the options show keystroke alternatives which you
can use instead of using the menu option. The 'hat' shape A represents Ctr!.
Press Ctr! and another key together to make the selection. A full list of
keystroke alternatives is given in the next chapter.
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To remove a menu, move the pointer off the menu and click Select.

The icon bar menu

To display the Acom Desktop Publisher icon bar menu, click Menu on the
application icon in the icon bar.
Info displays information about the program.
Page format displays the Page format dialogue box. It is not available when
you already have a document loaded.
Quit removes Acom Desktop Publisher from the computer's memory.

The main menu

Press Menu over the control panel or document window to display the main
menu. Move the pointer across the arrowhead to the right of each option to
display the submenus or dialogue boxes available.

DTP

Fi le
Uiew
Page
Fraflle
lfllports
Paragraph
Text style
Text edit
Graphics
Help
The File menu

;i

ii
ii
;i

ii
;i

ii
;i
;i

ii

Use the File menu to print a document, save a document or style sheet and
inspect statistics about a document. The menu offers these options:

File
Print ...
;i
Save docufllent
Save style sheet ii
Statistics ... ~z

-

Use Print to set various print options, such as the number of copies to print,
page range, forward or reverse order, and so on, and initiate printing.
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Use Save document to save a document with its existing name or a new name.
First, open a window for the directory where you want to save the document,
then drag the document icon to the window. The document will remain in the
computer's memory for further editing.
Use Save style sheet to save the style sheet with its original name or a new
name . Open the directory window for the directory where you want to save the
style sheet, and drag the style sheet icon to the window. Saving the style sheet
enables you to use it again for other documents.
Statistics displays information about the document in memory, including the
number of pages and words placed and unplaced in the document, and the
amount of RAM (working memory) available. The Statistics box may take a
while to appear, and, if you are using a single floppy disc drive, may prompt
you to change discs more than once.

The View menu

Use the View menu to control the display of your document on screen. It
offers these options:

Uiew
Double size
.J Actual size
Half size
Full page
Double page

nFS
nF9
nF18
nFU
nF12

Show rulers
Show fraflles and colufllns
.J Show pictures
Units

¢

The view size which is in use has a tick by it.
Double size shows the page at approximately twice the print size. It is useful
for detailed work on pictures and graphics or very small text.

-

Actual size shows the page at print size. It is useful for text editing.

Half size shows the page at half the print size. Use it for checking the overall
iayout of your document.
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Full page displays all the current page on the screen.
Double page shows a pair of facing pages on the screen.
Show rulers lets you hide or display the rulers at the top and lefthand edges
of the work area. When the rulers are displayed, the position of the pointer is
indicated by thin hairlines moving along them.
Show frames and columns lets you hide or display the outline of the frames
and guide columns on each page. Tum the guide columns on to help you to
align frames and check how much space is left in each column. Turn them off
to see what the page will look like when printed.
Show pictures lets you hide or display pictures. Turning the pictures off
considerably increases the speed at which the screen is redrawn. A diagonal
cross appears in place of each picture.
Units offers five different units of measurement:
• picas and points
• inches and tenths
• inches and eighths
• centimetres
• millimetres.
Click on the unit you want; it will be used on the rulers and elsewhere in the
application.

If the rulers are displayed, you can also change the units by clicking on the
unit description in the top lefthand comer of the document window where the
rulers meet.

-

The Page menu

Use the Page menu to move around the document, add, insert and delete
pages, set headers, footers and column guides, and set the print position. It
contains these options:

Page
Go to page, , ,
Add page
Insert page
Delete page
.J
.J

Headers and footers.,,
Header this page
Footer this page
Set coluMn guides.,,
Set print position ...

Go to page lets you move to any page of your document, including a master
page. You can tum backwards or forwards one page by clicking on one of the
arrows on the page icon.
Add page inserts a blank copy of the master page after the current page. If the
last page of the document is on screen, you can add a new page by clicking on
the right arrow on the page icon.
Insert page inserts a blank copy of the master page before the current page.
Delete page deletes the current page. You cannot delete the only page of a
single-page document.

-

Headers and footers lets you set headers and footers . Each header and foote r
can have up to three sections (one left-aligned, one centred, and one rightaligned), and can appear on left pages only, right pages only, or on both (if
you have two master pages). You can also set the distance from the top or
bottom of the page, and the page number to start numbering from. You can
ed it header and footer text only by using this menu option.
To set the text style, font, point size, indents, etc used in your headers and
footers, edit the paragraph styles called Header and Footer. These styles are
created when you set up your header and footer.
Header this page lets you tum the header on or off for the current page.

Ar.nm nP.!=:ktno Publisher menus

97

Footer this page lets you turn the footer on or off for the current page.
Set column guides (only available in frame mode) allows you to set:
• the number of columns on each page
• the top, bottom, left and right margins on each page
• the size of the gap between columns.
Set print position displays a dialogue box allowing you to set or change the
Vertical and Horizontal page offsets. These control the position of the
document on the printed page.

The Frame menu

Use the Frame menu to work with frames. Most of the options in this menu
can only be used in frame mode. The Frame menu offers these options:

.J

FraMe
Snap to guides

Frn11e bordel' . . .
Fl'aflle tint .. .
.J Repel text .. .
Size and position ...
Cut fraflle
Copy f raflle

"D
"C

Send to back
Bl'ing to f l'ont

"B
"F

Snap to guides lets you turn snapping on or off. When snapping is turned on,
frames snap to the column guides when created, moved, or stretched
(provided you are close to a guide line when you release the button). This
helps you align them correctly. The top and bottom edges of a frame snap to
the ruler spacing (centimetres, inches and tenths, etc) and the left and right
edges snap to the left and right edges of the column guides.
Frame border lets you choose a border in one of four different styles. You
can have a border at the top, bottom, left, or right of the frame, or any
combination of these.

OQ

Frame tint lets you choose a background tint. There are eight opaque tints
ranging from white through five levels of grey to black, and one transparent
tint.
Repel text lets you tum repelling on or off. The default action is for
superimposed frames to repel text in an underlying frame. You can also set
an extra area of padding around the edge of the frame which text cannot enter.
Size and position lets you resize and position frames with great accuracy. You
can set the horizontal or vertical position, and the width or height of the frame.
The position of a frame is measured from the top and lefthand edges of the
page it was drawn on. (Double-clicking on a frame in frame mode also
displays this dialogue box.)
Cut frame removes the selected frame from the work area and places it on an
imaginary clipboard. You can then paste it in somewhere else or leave it out
of the document. Any frame previously stored on the frame clipboard is lost
when you use this option, but the text and graphics clipboards are not affected.
Copy frame makes a copy of the selected frame and adds it to the clipboard.
Any frame previously stored on the frame clipboard is lost when you use this
option, but the text and graphics clipboards are not affected.
Paste frame pastes the frame on the clipboard on the current page, placing it
on the page in the position it had on the page it was copied from. If there is
another frame already there, the copy is pasted above and to the left of the
original frame .
Send to back places the selected frame behind any frames it covers.
Bring to front places the selected frame on top of any frames covering it.

The Imports menu

Use the Imports menu to work with imported text and pictures. The word
import in the menu is replaced by story, picture or drawing, depending on the
type of import you are working with. The Imports menu offers these options:

l11111orts
drawing.,,

Rena~e

Delete drawing
Crop picture
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in the browser changes when you click on OK
Delete import deletes every copy of a story or picture. A dialogue box asks
you to confirm or cancel the deletion.
Click on Crop picture to cut away part of the picture and rescale the rest. The
pointer changes to a pair of scissors. Using Select, drag a box inside the
picture to mark the portion you want to keep. Click anywhere outside the
frame or display the menus to finish cropping. To restore part of the picture
you have previously cropped, drag the box outside the frame.
You can only use Crop picture in frame mode with a picture selected.

The Paragraph menu

Use the Paragraph menu in paragraph mode to work with paragraph styles.
Changes to a paragraph style affect all paragraphs tagged with that style. To
change blocks of text within a paragraph, use Font/size in the Text style
menu. Text or font attributes chosen in text mode always take precedence
override any attributes set with the Paragraph menu.
To use most of the options in the Paragraph menu you need to select a
paragraph style.
The Paragraph menu offers these options:

ParaqraPh
Edit style ...
Hew style ...
Rena111e style ...
Delete style
Function key
¢
Edit style displays the Paragraph dialogue box allowing you to change the
attributes of an existing paragraph style. The different boxes, displayed when
you click on the appropriate box on the lefthand side, allow you to set these
text attributes:
• Font, size and style lets you set the font, point size, leading (inter-line
spacing) and text style.
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• Dimensions lets you set the margins, indents, minimum and maximum
space between words in ems, and hyphenation hot zone. If you set a l.arger
value for minimum space than for maximum space, the minimum space
value will be used as the maximum.
• Options lets you choose a bullet symbol, whether to hyphenate text, and
whether to allow additional spacing between letters when justifying text.
• Format lets you set the justification format: justified, flush left (ragged),
centred, flush right (right-aligned) or tabulated. If you choose tabulated
(Table) you can set up to ten tabs specifying the type (left, right, centre, or
decimal tab), position, leader character (spaces, underlines, dots), and how
much space to insert between each leader character.
You can also display the Paragraph style dialogue box by double-clicking on
a paragraph or paragraph style name.
New style lets you create a new paragraph style. Select a paragraph with a
style similar to the one you want to create. A dialogue box appears, with a
space for you to name the new paragraph style. The Paragraph dialogue box
then appears for you to set the attributes of the paragraph style. The dialogue
box is the same as that displayed by Edit paragraph style.
Rename style lets you type a new name for a paragraph style. When you
click on OK, the name in the browser changes.
Delete style deletes the selected paragraph style. A dialogue box gives you
the chance to confirm or cancel deletion. Any paragraphs which were tagged
with the deleted style revert to body text.
Function key lets you assign a function key to a paragraph style. You can
then use the paragraph style by pressing the key or clicking on its icon. If a
key is already assigned to the selected paragraph style, it is ticked in the list
of keys. The function key icons in the control panel show which styles are
allocated.
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block, or to set attributes for text you will type in afterwards. It offers these
opt ions:

Text st!lle
Font/size.,,
Bold
Under Ii ne
Italic
Light
Supet·scr i pt
Subscript
White

nFl
nF2
nF3
nF4
nF5
nF6

Text or font attributes set in text mode always override attributes set in
paragraph mode.
Font/size lets you choose a font and point size. The present font and point size
of the marked block is shown in the dialogue box. You can choose one of the
given sizes, or a different one in the Custom size box.
Click on Normal to reset the text to the fo nt, point size, and text style for the
current paragraph.
C lick on Bold to choose bold text.
C lick on Underline to choose underlined text.
C lick on Italic to choose italic text.
C lick on Superscript to choose superscript text.
C lick on Subscript to choose subscript text.
C lick on White to choose white text on a dark background (if the frame is
tinted).
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The Text edit menu

Use the Text edit menu in text mode to perform word-processing tasks. It
offers these options:

Text edit
fts
Find...
Replace.,,

ftR

0

Copq text

C

+ext

ftK
Kern
Soft hyphen Fl!
Fixed space F12
Use Find to look through your document for a string of text. The program
searches from the present cursor position in one direction to the end of the
document. If the string is fo und, it is marked as a block.
Use Replace to search for one string of text and replace it with another.
To repeat a Find or Replace operation, click on the Repeat find option. The
program searches from the present cursor position in one direction to the end
of the story.
Use Cut text to cut out a marked block of text and place it on an imaginary
clipboard. You can paste it in somewhere else later or leave it out of your
document. Any text previously stored on the text clipboard is lost when you
use this option, but the graphics and frame clipboards are not affected.
Use Copy text to copy a marked block of text to the clipboard without
deleting it from the document. You can paste the text elsewhere in the same
document or in a different document. Any text previously stored on the text
clipboard is lost when you use this option, but the graphics and frame
clipboards are not affected.
Use Paste text to insert the text on the clipboard at the cursor position.
Use Kern to move the two characters either side of the cursor closer together
or further apart. The dialogue box lets you specify the amount of kerning in
points, and whether to move the characters apart ( +) or together (-). T o switch
between + and -, click on the box containing the sign. You can also use Ctrl-K
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to move the characters together by half-point units without displaying the
dialogue box.
Use Soft hyphen to place a hyphenation point into a word at the cursor
position. If the word needs to be broken over a line division, it will be broken
at the point of the soft hyphen, otherwise the hyphen will not appear. Place a
soft hyphen at the start of a word to prevent it being hyphenated at all.
Use Fixed space to insert a fixed space at the cursor position. Use a fixed
space to link words or numbers that you do not want to be split over lines, or
where you don't want a space to be stretched during justification.

The Graphics menu - ,

Use the Graphics menu in graphics mode to create and work with graphics. It
offers these options:

Graphics
4 Show grid
4 Snap to grid
Line style,,,
Fill style.,,
Size and position.,,
Cut i tefll
Copy itefll
<l.>.
t

nD
nc

Send to back
Bring to front

nB
nF

Show grid lets you hide or display the graphics grid.
- Snap to grid lets you control whether graphics snap to the grid. Tum snapping
on to help you align graphic objects with each other.
Use Line style to choose:
• black or white 'ink'
• dotted, dashed, or solid lines
• line width
• arrowheads at one or both ends of the line.
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If a line is already selected, it will change to the new style. Otherwise, the
style will be used for the next line you draw.
Use Fill style to choose a fill style for closed shapes. There are eight opaque
fill styles, from white through six levels of grey to black, and one transparent
style. You can also choose whether to display the outer edge (perimeter) of
objects. If a solid object is already selected, the new fill style will fill it.
Otherwise it will be used for the next solid object you draw. Use Size and position to position graphics with great accuracy, and to make
fine adjustments to their sizing. You can set the horizontal or vertical position
and the width or height of the graphic object. The position of a graphic object
is measured from the top and lefthand edges of the frame it was drawn in.
You can also display the Size and position dialogue box by double-clicking
on a graphics object.
Cut item removes the selected graphic object and places it on the graphics
clipboard. You can then paste it in somewhere else or leave it out of your
document. Any graphics previously stored on the graphics clipboard are lost
when you use this option, but the text and frame clipboards are not affected.
Use Copy item to copy a selected graphic object to the clipboard without
deleting it. You can later paste the object into the document using Paste item.
Any graphics previously stored on the graphics clipboard are lost when you
use this option, but the text and frame clipboards are not affected.
Use Paste item to paste the graphic object on the clipboard into the currently
selected frame. The object is pasted in the equivalent position that it h ad in
the frame it was cut or copied from. If there is another object already there,
the copy is pasted in lower down and to the right of the original object.
Send to back places the selected graphic object behind any other graphics it
covers.
Bring to front brings the selected graphic object in front of any other
graphics covering it.

The Help menu

The Help option leads to a submenu offering information on nine topics.
C licking on the one you want displays the first of a series of windows. Click
on Next to move to the- next page, Previous to go back, and Exit to leave the
Help system.

Acorn Desktop Publisher menus
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1

Keystroke equivalents

When you become familiar with Acorn Desktop Publisher, you may find it
quicker and more convenient to use the keyboard instead of the mouse. This
chapter lists the keystroke equivalents you can use to move the cursor and call
up menus.

In frame mode

,..._,

Ctrl-B

Hide a frame behind any others it covers

Ctrl-F

Bring a hidden frame to the front

Ctrl-C

Copy a frame to the clipboard

Ctrl-D

Cut out a frame and save it on the clipboard

Ctrl-P

Paste in a frame from the clipboard

In text mode
Move the caret left one character

caret movement

Move the caret right one character

i

Move the caret up one line

1

Move the caret down one line

Shift-~

Move the caret right one word

Shift-

Move the caret left one word

f-

Delete the character to the left of the caret

Editing
Delete

Keystroke equivalents

Delete the character to the left of the caret (or
when a block is marked, cut it out and send it to
the clipboard)

107

Find and replace

Copy

Delete the character to the right of the caret

FlO

Insert a soft hyphen

Fll

Insert a fixed space

Ctrl-K

Kem two characters together by half a point

Ctrl-C

Copy a block of text to the clipboard

Ctrl-D or Delete

Cut out a block of text and send it to the clipboard

Ctrl-P

Paste in a block of text from the clipboard

Ctrl-S

Find

Ctrl-R

Replace

Ctrl-A
Text style

In graphics mode
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, Repeat the last Find or Replace operation

Ctrl-Fl or Shift-Fl

Toggle bold text

Ctrl-F2 or Shift-F2

Toggle underlining

Ctrl-F3 or Shift-F3

Toggle italic text

Ctrl-F4 or Shift-F4

Toggle light text

Ctrl-F5 or Shift-F5

Toggle superscript text

Ctrl-F6 or Shift F6

Toggle subscript text

Ctrl-F7 or Shift-F7

Switch to normal text

Ctrl-B

Hide a graphic object behind any others it covers

Ctrl-C

Copy a graphic object to the clipboard

Ctrl-D

Cut out a graphic object and send it to the
clipboard

Ctrl-F

Bring a hidden graphic object to the front

Ctrl-P

Paste in a graphic from the clipboard

KeY.stroke equivalents

-

In any mode

View
--,
,_....,

Ctrl-FS or Shift-FS

Display page at double size

Ctrl-F9 or Shift-F9

Display page at actual size

Ctrl-FlO or Shift F-10

Display page at half size

Ctrl-Fl 1 or Shift F-11

Display whole page

Ctrl-F12 or Shift-F12

Display two pages together

Ctrl-Z

Display statistics

Print

Print a document

,.......,

Miscellaneous

,.....,

-

1 1"

Kevstroke eauivalents

Glossary

-,

----,

-

Word

Definition

ASCII text

Acronym for American Standard Code for Information
computer code used to represent letters and numbers.

Baseline

An imaginary line connecting the bottoms of capital letters.

Binding margin

Extra space added to the side of a printed page to allow for punching or
binding. It is usually on the lefthand side of a right page and the righthand
side of a left page.

Bold text

Text characterised by thick, heavy lines.

Bullet

A heavy dot or other symbol, used to introduce a paragraph or list item.

Caret

A thin I-shaped vertical bar which indicates where typed text will appear or
editing will take place.

Case

Letters can be either upper case (CAP ITAL LETTERS) or lower case (small
letters).

Centred text

Text which is positioned halfway between the left and right margins of its
frame.

Character

Any single letter, number, punctuation mark, or symbol.

Clipboard

A temporary holding place for a block of text, a frame, or a graphic object
which has been cut or copied. Acom Desktop Publisher has three clipboards,
one each for text, graphics and frames.

Column guides

Dotted lines showing the edges of the columns on each page. These are not
printed.

Interchange.

A
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Crop

Mask unwanted areas of a picture file.

Cut

Remove a block of text, a frame, or a graphic object from a document and
place it on the clipboard.

Decimal tab

A tab stop which aligns columns of decimal numbers on the decimal point.

Default

What the computer will assume you want unless you tell it otherwise.

Em

A unit for measuring width which is equivalent to the point size of the font in
use.

Fixed space

A space used to keep words together on the same line. This space is never
'stretched' during justification.

Font

A complete set of characters of the same design. The same as 'typeface'.

Footer

A line of text which appears at .the bottom of every page.

Format

The visual appearance of a page of text, including its shape, size, margins, etc.

Frame

A rectangular box used to hold text, pictures, or graphics.

Grid

A pattern like graph paper within a graphics frame. All graphics are
fastened to the grid points on this 'graph paper' when they are drawn or
moved.

Handles

Small open squares on the edges and comers of a selected frame or graphic
object which are used for resizing. The handles show when the frame or
graphic object is selected.

Hanging indent

A paragraph style in which the first line is flush with the left margin and
subsequent lines are indented.

Header

A line of text which appears at the top of every page.

Highlight

To emphasize an area of text in inverse video.

Hyphenation

Placing a hyphen where a word has been split at the end of a line.

Hyphenation hot zone

An area at the end of every line which is used to determine hyphenation when
setting ragged text. If a line has a long word at the end of it, and is in danger
of crossing into the hot zone, Acom Desktop Publisher will try to hyphenate
that word.
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Image file

A picture consisting of dots, created with a painting program or a scanner.

Import

Load text or a picture created with another program into Acorn Desktop
Publisher.

Indent

The gap between the lefthand or righthand margin of a frame and the start or
finish of the lines of text.

Italic text

A style of text characterized by letters slanting to the right.

Justified text

Text which is flush with both the left and right margins, like the main
paragraphs of text in this Guide. To justify text, Acorn Desktop Publisher
adds extra space between the words and letters in each line.

Kerning

Adjusting the spacing between pairs of characters to create a more pleasing
effect.

Leader

A row of characters, usually dots, used to guide the eye across the page.
Leader characters are often used in tabulated text.

Leading

The distance between the baseline of one line of text and the next.

Letter spacing

When text is justified, extra space is inserted between the words in each line.
If this space is larger than a maximum value you have set, then extra space is
added between the letters in each word.

Line art file

A picture consisting of lines, curves, etc, created with a drawing program.

Marked block

A highlighted section of text which can be cut out, copied, moved or restyled.

Master page

A page which acts as a template for any new pages added to a document.

Page layout

The arrangement of text, pictures, and graphics on a page.

Paragraph style

The name for a particular type of paragraph with its own set of features such
as font, point size, bullets, indents.

Paste

Insert the contents of the clipboard into a document.

Pica

A typesetting unit of measurement equal to 1/6 of an inch.

Picture format

The kind of file (line art or image) a picture has been stored as.

Point

A typesetting unit of measurement equal to 1/72 of an inch.

f::lnc:c:::irv
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Point size

The height of a font measured in points.

Ragged text

Text which is flush with the left margin and uneven on the right margin.

Repel text

Make text run around the outline of a frame. This prevents the text in a frame
overlapped by another being hidden.

Right-aligned text

Text which is flush with the right margin and uneven at the left margin.

Serif

The small bars across the ends of lines in some fonts (like this one). Fonts
without these bars are called sans-serif.

Snap

Restrict the positioning of a frame or a picture so that it can only be placed
on the current ruler divisions or column guides.

Soft hyphen

A hyphen which overrides any automatic hyphenation by the program. Place a
soft hyphen at the beginning of a word to prevent a word being hyphenated at
all.

String

A series of characters and/or spaces of any length.

Style sheet

File storing information about the master page, page format and paragraph
styles for a document.

Subscript

Text in a reduced point size which is dropped below the baseline of the
surrounding text.

Superscript

Text in a reduced point size which is raised above the baseline of the
surrounding text.

Tab stop

A marked position on a ruler for aligning text in columns using the Tab key.

Toggle

An option that you turn on or off using the same action (usually clicking on a
box or command name).

Word spacing

Adjustment of the minimum and maximum amount of space allowed between
words.

11 .1
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Publisher on your computer

The distribution discs

Program disc

Acorn Desktop Publisher is supplied on three discs - two containing the
application (the Program and Work discs) and a third with examples
(Examples) . The files on these discs are structured as follows :
The Program disc contains two directories - ! DTP and Pdri vers:
$

Pdrivers

!DTP

! DTP is the application directory containing the Acorn Desktop Publisher
program. Pdrivers is a directory containing the printer drivers which enable
you to print your output on various different types of printer.

---,

Work disc

The Work disc also contains two directories - ! DTPWork and ! F onts:
$

!F onts

!DTPWork

! DTPWork contains the standard style sheets used with the program, while
all the fonts used with Acorn Desktop Publisher are included in the directory
! Fonts.

Examples disc

The Examples disc has five directories:

-

$

Documents

Images

LineArt

Styles

Stories
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-

you get to know Acom Desktop Publisher, and 'clip art' which you can use in
your own documents.
You should never work from the distribution discs supplied - before you start
to use Acom Desktop Publisher you should make working copies of all three
discs on new 'E' format floppy discs, or if you have a hard disc, on your hard
disc. If you will be running Acom Desktop Publisher from floppy discs,
follow the procedure detailed in The Advanced Disc Filing System of the User
Guide for making backup copies of floppy discs. It is recommended that you
keep the same files and directories on each disc, in the same structure as on
the distribution discs. When you have made copies, label them appropriately.

Installing Acorn
Desktop Publisher on
a hard disc

If your system has a hard disc, use the RISC OS file copying procedure to
copy the directories from the distribution discs to your hard disc. Acom
Desktop Publisher directories do not have to be ordered in a particular
structure on your disc in order to work, but the following approach is the most
efficient:
1 Create a DTP directory at the root.
2 Copy ! DTP (from the Program disc), ! DTPWork (from the Work disc) and
all the Examples directories into DTP.
3 Copy the Pdrivers directory from the Program
directory on your hard disc. These new printer drivers
RISC OS applications, so you can delete the printer
the RISC OS Applications suite (or archive them to
these new ones instead.

disc into the root
can be used with all
drivers supplied with
floppy disc) and use

4 Copy the ! Fonts directory from the Work disc to the root directory on
your hard disc. As with the Acom Desktop Publisher printer drivers, these
new fonts may be used with all suitable RISC OS applications, so you can
remove the fonts supplied with the RISC OS Applications suite from your
hard disc and archive these to a floppy disc as well.
5 Change the disc drive configured in the dtp_config file in !DTP from
fl o ppy disk to harddisk (see Configuring Acom Desktop Publisher in the
next appendix).
Acom Desktop Publisher is now installed on your hard disc.

Loading and running
Acorn Desktop
Publisher

11h

Before you load the application, see the next appendix for the best way to run
Acom Desktop Publisher, which depends on the specification of your
computer.
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Appen dix B: Runnin g Acorn Desktop
Publisher on your computer

How you actually run Acom Desktop Publisher depends on the computer and
disc drives you are using, in particular:
• how much memory your computer has
• whether you have a hard disc, two floppy disc drives, or a single floppy
disc drive.
This appendix describes exactly what you should do in each case. It is divided
into two main sections: you should follow the instructions given in the first
section (Fl.oppy disc users) if you have a computer without a hard disc, and those
in the second section (Hard disc users) if you do have a hard disc. In each case,
there are instructions telling you what to do if your computer has lMb of
memory, or if it has 2Mb or more.
The sections entitled Configuring Acom Desktop Publisher and Configuring the
Font Manager tell you how you can fine tune the software and your system to
suit your particular requirements.
Finally, the appendix tells you about the printer drivers supplied.

Floppy disc users

Read this section if you will be using Acom Desktop Publisher on a computer
fitted with floppy discs only.
As mentioned in the previous append ix, first make working cop ies of the three
distribution discs. In addition, you will probably want another formatted disc
for storing your own Acom Desktop Publisher documents, though to begin
with, you could use your working copy of the Examples disc.

Computers fitted with

1Mb RAM

Acom Desktop Publisher is a complex piece of software and takes up nearly
all the resources in a lMb computer. This means that you need to be careful
about how you start the application. Follow these steps:
Make sure you have saved any work you have been doing in other
applications.
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2 Reset the computer to its default state by holding down Ctr! and pressing
the Reset button. This ensures that there are no applications or modules
consuming valuable memory.
3 Select an appropriate screen mode. Although Acorn Desktop Publisher is
designed to be used in any screen mode, your choice is limited on a lMb
computer:
• if you want a colour display, use mode 12 on both standard resolution
and multi-frequency scanning rate monitors
• if you want a monochrome display, use modes 8 or 11 on standard
resolution monitors and mode 19 on multi-frequency scanning rate
monitors.
To change mode, use the palette: its icon is towards the right of the icon
bar. For instructions on how to use the palette, refer to the User Guide
supplied with your computer.
4 Put the Acorn Desktop Publisher Work disc into drive 0 and click on the
drive icon on the icon bar. This tells the computer about the !DTPWork
directory and where it can find the fonts it needs. These actions are carried
out automatically.
5 If you have a single floppy disc drive, replace the Work disc with the
Program disc and click on the drive icon again. On a twin floppy dri~e
system, insert the Program disc in drive 1 and click on its icon, leaving the
Work disc in drive 0.
6 If you intend to use a printer in the current session, open the window for
the directory containing the printer drivers and double-click on the icon for
your type of printer. After a few seconds, the printer icon will appear on
the icon bar. Refer to your User Guide for how to set up the printer; if you
expect to use the same printer all the time, save the settings so that you do
not need to set them every time.
7 Acorn Desktop Publisher does not actually use the printer driver itself,
only part of it (the module). You should therefore release more space by
removing the printer driver (by selecting Quit from its icon bar menu);
although the icon disappears from the icon bar, the module that you need
remains behind.

8 Use the Task Manager, described in your User Guide, to optimise the
workspace available for Acorn Desktop Publisher.
First check that there are no application tasks present (such as the printer
driver mentioned in steps 6- 7), then look at the System memory allocation and

11 A
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Application tasks parts of the display. Make the following settings:
• screen memory: maximum BOK
• font cache: at least 64K
• system sprites: OK (this area is not used by Acom Desktop Publisher)
• Next slot: 600K.
This leaves a small amount of memory in the Free slot, which is needed as
a buffer when printing. The first three of these settings can be set using
configuration commands, so that you do not need to change them every time.
For how to do this, refer to your User Guide.
9 Finally, load Acom Desktop Publisher by double-clicking on its icon in
the directory window, or by using any of the methods described at the
beginning of the chapter entitled Basic techniques.

If you have two floppy disc drives, try to leave the Work disc in drive 0
permanently, using drive 1 for discs containing documents to be loaded or
saved.
Whether you have one or two floppy disc drives, it is vital that you
respond to all requests for disc exchanges.

Computers fitted with
2 or4Mb RAM

As you might expect, additional memory gives you greater flexibility in your
use of Acom Desktop Publisher. In particular:
• You do not need to reset the computer in order to restore default
conditions; you can therefore multi-task Acom Desktop Publisher with other
RISC OS applications such as Edit, Draw and Paint.
• Given a suitable monitor, Acom Desktop Publisher may be run in any
screen mode. In particular, if you have a high-resolution monitor you can
produce a high-quality colour display by using mode 20.
Take these steps to load the application:

-

1 Put the Acom Desktop Publisher Work disc into drive 0 and click on the
drive icon on the icon bar. This tells the computer about the ! DTPWork
directory and where it can find the fonts it needs. These actions are carried
out automatically.
2 If you have a single floppy disc drive, replace the Work disc with the
Program disc and click on the drive icon again. On a twin floppy drive
system, insert the Program disc in drive 1 and click on its icon, leaving the
Work disc in drive 0.

t.nnonrliv

R· 1=!1 inninn At'nrn nAc:ktnn P11hlic:hP.r nn VntJr r.omnuter

119

3 If you intend to use a printer in the current session, open the window for
the directory containing the printer drivers and double-click on the icon for
your type of printer. After a few seconds, the printer icon will appear on
the icon bar. Refer to your User Guide for how to set up the printer; if you
expect to use the same printer all the time, save the settings so that you do
not need to set them every time.

4 Acorn Desktop Publisher does not actually use the printer driver itself,
only part of it (the module). You can therefore release more space, if you
want to, by removing the printer driver (by selecting Quit from its icon bar
menu); although the icon disappears from the icon bar, the module that you
need remains behind.
5 Provided there is sufficient memory (at least 600K) in the Next slot and an
adequate font cache (at least 64K), start Acorn Desktop Publisher by
double-clicking on its icon in the directory window, or by using any of the
methods described at the beginning of the chapter entitled Basic techniques.
If you have two floppy disc drives, try to leave the Work disc in drive 0
permanently, using drive 1 for discs containing documents to be loaded or
saved.
Whether you have one or two floppy disc drives, it is vital that you respond to
all requests for disc exchanges.

Improving performance
on computers fitted
with 2 or 4Mb RAM

You can improve the performance of Acorn Desktop Publisher on floppy disc
systems with 2 or 4Mb of RAM by increasing the size of the Next slot and the
font cache to, say, lMb and 256K respectively. To change these settings, use
the Task Manager, described in your User Guide. However, the extent to which
you will want to do this depends on what other applications - if any - you
want to run alongside Acorn Desktop Publisher.
There is an alternative way of improving performance which is particularly
effective on single floppy disc systems. This is to use the additional memory
as a RAM disc. Take the following steps:
1 Use the Task Manager to allocate a RAM disc of about 600K.

2 Click on the RAM disc icon to open its directory window.
3 Put the Acorn Desktop Publisher Work disc in drive 0, click on its icon to
open the directory and copy both ! DTPWork and ! Fonts to the RAM
disc directory window.
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4 C lose the Work disc window and then double-click on each of the
! DTPWork and ! Font directories in the RAM directory window. This
tells the computer to look in the RAM disc for these resources.
5 Replace the Work disc with the Program d!sc and load a printer driver
and Acom Desktop Publisher as described above. Twin floppy drive users
can use drive 1 for their own discs.
It is, of course, possible to combine a number of these techniques to create a
highly custom ised system.

Hard disc users

Read this section if you will be using Acom Desktop Publisher on a computer
fitted with a hard disc drive.

If you have not already done so, copy the Acom Desktop Publisher
distribution discs as detailed in the previous appendix. You need directories
for:
• the Acom Desktop Publisher application
• the Acom Desktop Publisher working directory
• the example material
• the printer drivers.
You may also wish to create a new directory to hold your Acom Desktop
Publisher documents.

Computers fitted with
1Mb RAM

Acom Desktop Publisher is a complex piece of software and takes up nearly
all the resources in a lMb computer. This means that you need to be careful
about how you start the application. Follow these steps:
Make sure you h ave saved any work you have been doing in other
applications.
2 Reset the computer to its default state by holding down Ctrl and pressing
the Reset button. This ensures that there are no applications or modules
consuming valuable memory.
3 If your hard disc has a boot sequence which installs other applications or
which might otherwise alter the default conditions, you should hold down
both Ctrl and Shift while pressing Reset; this will prevent the boot
sequence from being executed.
4 C lick on the hard disc icon so that its window appears on the screen.
Provided you have fo llowed the instructions given in the previous appendix,
this action will tell the computer where it can find the fonts it needs.
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5 Select an appropriate screen mode. Although Acom Desktop Publisher is
designed to be used in any screen mode, your choice is limited on a lMb
computer.
• if you want a colour display, use mode 12 on both standard resolution
and multi-frequency scanning rate monitors
• if you want a monochrome display, use modes 8 or 11 on standard
resolution monitors and mode 19 on multi-frequency scanning rate
monitors.
To change mode, use the palette: its icon is towards the right of the icon
bar. For instructions on how to use the palette, refer to the User Guide
supplied with your computer.
6 If you intend to use a printer in the current session, open the window for
the directory containing the printer drivers and double-click on the icon for
your type of printer. After a few seconds, the printer icon will appear on
the icon bar. Refer to your User Guide for how to set up the printer; if you
expect to use the same printer all the time, save the settings so that you do
not need to set them every time.
7 Acom Desktop Publisher does not actually use the printer driver itself,
only part of it (the module). You should therefore release more space by
removing the printer driver (by selecting Quit from its icon bar menu);
although the icon disappears from the icon bar, the module that you need
remains behind.
8 Use the Task Manager, described in your User Guide, to optimise the
workspace available for Acom Desktop Publisher.
First check that there are no application tasks present (such as the printer
driver mentioned in steps 6-7), then look at the System memory allocation and
Application tasks parts of the display. Make the following settings:
• screen memory: maximum BOK
• font cache: at least 64K
• system sprites: OK (this area is not used by Acom Desktop Publisher)
• Next slot: 600K
This leaves a small amount of memory in the Free slot, which is needed as
a buffer when printing. The first three of these settings can be set using
configuration commands, so that you do not need to change them every time.
For how to do this, refer to your User Guide.
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9 Open the directory window contammg ! DTP and ! DTPWork. This action
will set up the Acorn Desktop Publisher Work directory automatically.
10 Finally, load Acorn Desktop Publisher by double-clicking on its icon in
the directory window, or by using any of the methods described at the
beginning of the chapter entitled Basic techniques.

Computers fitted with

2 or4Mb RAM

As you might expect, addit ional memory gives you greater flex ibility m your
use of Acom Desktop Publisher. In particular:
• You do not need to reset the computer in order to restore default
conditions; you can therefore multi-task Acorn Desktop Publisher with other
RISC OS applications such as Edit, Draw and Paint.
• Given a suitable monitor, Acom Desktop Publisher may be run in any
screen mode. In particular, if you have a high-resolution monitor you can
produce a high-quality colour display by using mode 20.
The basic procedure for loading and running Acom Desktop Publisher in
these conditions is described below, followed by some suggestions for using
the additional memory to improve performance.
1 If you intend to use a printer in the current session, open the window for
the directory containing the printer drivers and double-click on the icon for
your type of printer. After a few seconds, the printer icon will appear on
the icon bar. Refer to your User Guide for how to set up the printer; if you
expect to use the same printer all the time, save the settings so that you do
not need to set them every time.
2 Acom Desktop Publisher does not actually use the printer driver itself,
only part of it (the module) . You can therefore release more space, if you
want to, by removing the printer driver (by selecting Quit from its icon bar
menu); although the icon disappears from the icon bar, the module that you
need remains behind.
3 Provided there is sufficient memory (at least 600K) in the Next slot and an
adequate font cache (at least 64K), start Acom Desktop Publisher by
double-clicking on its icon in the directory window, or by using any of the
methods described at the beginning of the ch apter entitled Basic techniques.
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Improving performance
on computers fitted
with 2 or 4Mb RAM

You can improve the performance of Acorn Desktop Publisher on hard disc
systems with 2 or 4Mb of RAM by increasing the size of the Next slot and the
font cache to, say, lMb and 256K respectively. To change these settings, use
the Task Manager, described in your User Guide. However, the extent to which
you will want to do this depends on what other applications - if any - you
want to run alongside Acorn Desktop Publisher.
There is an alternative way of improving performance, using the additional
memory as a RAM disc. Take the following steps:
Use the T ask Manager to allocate a RAM disc of about 600K.

2 Click on the RAM disc icon to open its directory window.
3 Put the Acorn Desktop Publisher Work disc in drive 0, click on its icon to
open the directory and copy both ! DTPWork and ! Fonts to the RAM
disc directory window.
4 C lose the Work disc window and then double-click on each of the
! DTPWork and ! Fon t directories in the RAM directory window. This
tells the computer to look in the RAM disc for these resources.

Configuring Acorn
Desktop Publisher

The file dtp con fig in the ! DTP application directory allows you to
configure Acom Desktop Publisher to suit your own requirements in the
fo llowing areas:
• font names
• quick scrolling
• slave files
• discs
• default style sheet.
These parameters are changed by editing the file dtp_config, which you
can do in Edit. See the User Guide if you are not sure how to use Edit.

Editing dtp _ config

To d isplay dtp config, hold down Shift and double click on the ! DTP icon.
Load Edit onto the icon bar, then drag dtp config from the application
directory onto the Edit icon. The dtp config file will be displayed, giv ing
information about each of the parameters you can change.

Font names

You will probably not need to change the font names unless you are adding
new fonts to the system. These must be outline fonts to the correct format.
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Quick scrolling

The quickscroll option allows users of 2 and 4Mb systems to speed up the
scrolling of pages in the document window. This is achieved by using memory
to maintain a sprite representing the current page. You set quickscroll by
changing the default parameter noquickscro ll to quickscroll . Just edit
out no, and close up to the margin again.

Slave files

slav e file s are files used by Acom Desktop Publisher to save internal
information while running, and will not normally need to be changed.

Discs

If you are running Acom Desktop Publisher from a hard disc (or from a
RAM disc on a 2Mb or 4Mb system), you should also change the default
parameter fl o pp y d i sk in the dtp_config file to harddi s k.

Default style sheet

The default style sheet used is dtp style in the directory ! DTPWork. If
you want to change this to an alternative file, edit it to show the pathname of
the file you want to use instead.

Configuring the Font
Manager

Displaying and printing fonts is an extremely complex process and Acom
Desktop Publisher is supplied with a new, highly sophisticated font
management system. The new system, which is also suitable for use with other
RISC OS applications making use of fonts, is loaded automatically when the
directory containing the ! Fonts application (the Work disc) is first opened.
As supplied, the new font management system (Font Manager) is set up to
provide a reasonable blend of screen quality and performance for the
majority of users (typically those with 1 or 2Mb RAM). However, it is
possible to change the Font Manager's settings to produce a system with
different characteristics, as described below.

Font cacheing

-

The Font Manager utilises 'cacheing' (allocating a portion of RAM to fonts
being used, in order to speed up access to them) to improve performance. The
size of the font cache determines the frequency with which the Font Manager
will have to access a disc to obtain font information. Subject to the constraints
imposed by your system, you can decide how much memory the Font Manager
may use for its cache. This is done by setting the Font cache size in the Task
Window, or by using *Configure FontSize to set the power-on default
value.
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Font quality

The new Font Manager uses two sophisticated techniques to improve the
quality of fonts:
• hinting
• anti-aliasing.
'Hinting' makes subtle changes to the shapes of characters so that a character
looks right, regardless of the size to which it is scaled.
'Anti-aliasing' is a technique in which grey pixels (the dots on the screen) are
used to make curves appear smoother, making a character look better on the
screen when few pixels are available.
Different people have different perceptions of quality. Only you can decide
how important character quality is, and how much computer time and memory
you are prepared to spend on the quality of the results you see on the screen.
These features can be set up as part of your computer's configuration, using
the FontMax parameters listed below. These are set using the *CONFIGURE
command (explained in the User Guide chapter Configuration commands). An
example of their use would be *CONFIGURE FontMax2 15, which would
set the FontMax2 parameter (see below) to its default value.

FontMaxl

FontMax2

This is used for controlling mixed use of outline and bitmap fonts. It is of
little importance to most users and should be ignored.
This parameter sets the maximum height of anti-aliased characters, in pixels.

If a character is larger than this value, then anti-aliasing will not be used. If a
character is larger than this, but smaller than that specified by FontMax3 then
it will be displayed without anti-aliasing, using cache space more efficiently.
The default setting is 15 pixels - set this to 0 to turn anti-aliasing off entirely.
FontMax3

FontMax3 sets the maximum size of bitmap in the font cache. If a character
to be drawn is larger than this size, the outline will be drawn directly to the
screen (or printer) with no cacheing at all. This is so that document headings,
where a few larger characters appear, do not flush everything else out of the
font cache.
The default setting is 30 pixels.

FontMax4

1 'J~

FontMax4 controls horizontal sub-pixel anti-aliasing, in which character
quality is improved by cacheing four versions of each character. This can have
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a noticeable effect on character quality at small sizes but for most users the
delay involved is unacceptable. Thus, most users leave this at the default
value of 0.

-

anti-aliasing.

Almost

all

users

FontMax5

This parameter controls vertical sub-pixel
leave this at the default value of 0.

FontMax

It is possible for the font cache to grow if it is definitely too small. The value
of FontMax specifies the maximum size to which the cache may grow. Most
users can ignore this setting.

Troubleshooting

If every repaint on the screen causes intensive disc and hourglass activity then
the font cache may be too small to hold the range of fonts you are trying to
use. In these circumstances, try the following:
1 Increase the size of the font cache using the Task Window. The addition of
even small amounts of memory can often improve things dramatically.

2 Reduce the maximum size for anti-aliasing (or switch it off altogether) by
changing the value of FontMax2. This will enable the font cache to be
used more economically with a large number of fonts.
3 Reduce the F o ntMa x3 value (or set it to zero) . This should reduce disc
activity, but the action of painting on the screen will become much slower.

Printing

When printing, there are conflicting requirements for memory. The Font
Manager needs memory to cache fonts, and the printer driver needs memory
to build up a page image to send to the printer. Both of these affect printing
speed and you will have to experiment to find the optimum. Changing to a
'smaller' screen mode (even mode O), for instance, can speed up printing
considerably.
As a general rule these remarks do not apply to PostScript printing, which
operates in a different way.
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Printer drivers

Acom Desktop Publisher provides at least the following printer drivers. New
drivers are being developed all the time, and you should look at the ReadMe
file in the Pdrivers directory on the Program disc for the range available
when your copy of Acom Desktop Publisher was released.
Printer driver

Supporting

!PrinterDM
!PrinterPS
!Printerlx
!PrinterLJ

All Epson dot matrix printers and compatibles
All PostScript laser printers
lntegrex 132
HP Laserjet II and compatibles

-

1 ?A
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Appendix C: Acorn Desktop Publisher
character sets

The Latin character
set

The following is a list of the characters available within each Latin font
supplied with Acorn Desktop Publisher. Characters not appearing on the
keyboard can be obtained by holding down the lefthand Alt key and typing
the corresponding number from the numerical keypad.
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The Selwyn font

Selwyn characters have been grouped together by type of character. To display
the character shown, hold down the lefthand Alt key and type the
corresponding number from the numeric keypad.
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Appendix D: The Hyphenation Exception
Dictionary

The Hyphenation
Exception Dictionary

Acom Desktop Publisher has a system of automatic hyphenation, using a set
of hyphenation rules and an Exception Dictionary. The Exception Dictionary
contains words that are exceptions to the basic hyphenation rules, and words
that you do not wish to be hyphenated at all.
You can edit the Hyphenation Exception Dictionary directly. For example,
you may want to add proper names to the list of words not to be hyphenated.
However, you must obey the following rules, or the program may not be able
to use the dictionary properly.

-

Make a backup copy of the Hyphenation Exception Dictionary before you
start editing it. If you have any problems using Acom Desktop Publisher with
the edited Hyphenation Exception Dictionary, you will then be able to go
back to the unedited version.

How to edit the
Dictionary

The Hyphenation Exception Dictionary is a file called dtp _hyphe n. Use
Edit or a word processor like 1st Word Plus to edit it. These rules shou ld be
followed when editing the Hyphenation Exception Dictionary:
1 Add words to the list in strict alphabetical order. If in doubt, refer to the
position of the letter in the character set (see Acom Desktop Publisher
character sets in Appendix C). If you do not wish a word to be hyphenated
at all, add the word to the list without a hyphen.
2 Place a hyphen wherever you wish a word to be hyphenated. You can insert
more than one hyphen.

-

3 Save the file in ASCII format. If you are using 1st Word Plus, do this by
switching off word-processing mode. If you are using Edit, the file will be
saved in ASCII format anyway.
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Appendix E: Error messages

The following is a list of the error messages which are most likely to be seen
while running Acorn Desktop Publisher, together with an indication of the
cause and advice about what to do next.

....,

Error

Meaning and action to be taken

Error when loading file

An unspecified error has prevented a file from being loaded. If this happens
on start up, it may be due to a file having been left open earlier when an
error had developed. In this case, press Fl 2 to get to the command line and
type *Shut to close any open files, then restart Acorn Desktop Publisher.

Completely out of memory
Save your work now

All the memory available to Acorn Desktop Publisher has been used up.
Save your work directly. You may be able to claim more memory by closing
other applications not needed, changing to a lower resolution screen mode,
unplugging unused modules or switching off anti-aliasing to reduce font cache
requirements. See Appendix B for the most memory-efficient way to run Acorn
Desktop Publisher on your particular computer.

Operation cancelled
Insufficient memory

The action you have attempted would make Acorn Desktop Publisher run out
of memory, so it has not been performed. You can otherwise continue working
normally.

No printer driver is loaded
Load a RISC OS printer
driver before printing your
document

Acorn Desktop Publisher uses RISC OS printer drivers for printing out
documents. Load an appropriate printer driver onto the icon bar and try to
print again.

The window is too small

Go to the Actual size view and expand the window before retrying.

for the requested view
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The fonts listed in your
configuration file do not
match those available on
the system

You have either started the system with the old RISC OS 2.0 Font Manager or
have added a font to the system without updating the configuration file
dtp config in ! DTP.

Unable to start new print

The printer is already busy printing. You need to wait until the previous job
finishes before retrying.

job

There are no fonts
available on your system.
Check your Font Manager
installation

The ! Fonts application has not been seen by the system before Acom
Desktop Publisher was started. Open a directory viewer containing ! Fonts
before continuing.

You may only edit one
document at a time.
Abandon the document
you are editing before
loading another

Acom Desktop Publisher can only cope with a single document at a time. You
have tried to load a second before you have finished correctly with the first .
Save your current work and quit the document window before you attempt to
load another document.

Not a valid DTP file

The Acom Desktop Publisher file being read in is either corrupt or has its
file type incorrectly set to that of an Acom Desktop Publisher data or style
sheet file.

Internal Error #1

Save your work immediately to a new file, exit and restart the program. There
is a possibility that the final file saved has been corrupted.

Internal error #2

None of these errors should occur during the normal operation of Acom
Desktop Publisher. Reset your machine and restart Acom Desktop Publisher.

No stack for trap handler
Error at i.aNNNbNNN
on line MMM

-

-
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A
Acorn Desktop Publisher
configuring 124-125
contents of package 6
distribution discs 115-116
FontM.anager 125-127
hardware requirements 5
quitting 35, 44
running 117-127
ASCII 111

character sets 59, 129-131
clipboard 111
frame 53, 99
graphics 76, 105
text 66, 103
column guides 16, 47
displaying 96
setting 98
snap to 50, 98
control panel 13, 39

D
B
baseline 111
binding margin 79
border
adding to frame 24
browser 13, 40, 66
in frame mode 22
in graphics mode 69
in paragraph mode 85
in text mode 56
bullet style 28
bullets 59, 82, 87, 101

...,

c
character
accented 59
bullet 59
leader 113

Index

default 112
dialogue box
removing from screen 11
directory structure 116
discs
floppy 117-121
hard 121-124
RAM. 124
distribution discs
making working copies 116
document 7
closing 44
moving around in 43
saving 34-35, 43-44, 95
statistics 95
steps in creating 10
document window 13, 38-39
changing size 23
scrolling 23
137

drawing tools 70

E
em 112
error messages 135-136
Examples disc 115

F
fill style 105
find and replace 62, 103
font 65, 83, 86, 100, 102, 112, 116,
124-127
anti-aliasing 126
hinting 126
Fontfont
caching 125
FontMax parameters 126-12 7
footer 83-84, 97, 112
frame 7, 47-53
adding picture 66
border 24, 51-52, 98
bring to front 51, 99
changing shape 48
copying 17-18, 53, 99
cutting 53, 99
deleting see frame, cutting
deselecting 48
drawing 16-1 7, 48
flow ordering 57
handles 48
hidden 48
maximum number 47
moving 18, 49
moving accurately 99
outline 96
overlapping 51, 52
pasting 53, 99
repelling text 51

1~A

resizing 19, 28, 48, 57
resizing accurately 50, 99
send to back 51, 99
snap to guides 50
space around 59
stacking 51
tint 52, 99
transparent 52, 99
freehand line 71
function key boxes 41
function keys 41, 88, 89, 101

-

G
graphic object
bring to front 105
checking size and position 76
copying 76, 105
cutting 76, 105
moving 74
moving accurately 75, 105
pasting 76, 105
resizing 75
resizing accurately 75, 105
send to back 105
graphics 69-76
grid 104, 112

-

H
hard disc
installing on 116
header 83-84,97, 112
headline
adding to page 24
style 28
help
displaying on screen 14, 105
hyphen
soft 63, 104, 114

Index
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hyphenation 29, 63, 82, 87, 101, 104,
133
hot zone 82, 87, 101, 112
preventing 133
Hyphenation Exception Dictionary
63, 133

I
image 66
import
deleting 100
placing in frame 21
renaming 100
importing text and pictures 20-21,
54-56,99
indent 83,101,113
hanging 83, 112

J
justification 30, 101

K
kerning 63-64, 103, 113
keyboard
foreign 59
keystroke equivalents 107-109

L
landscape format 79
leading 81, 86, 100, 113
letter
spacing 82, 87, 101, 113
line art 66
line spacing see leading
line style 73, 104

Index

M
margin
binding 111
margins 87, 101
master page 9, 79-80
designing 14-19
displaying 14, 80
memory
lMb 117-119, 121-123
2 or 4Mb 119-121, 123-124
optimising use 118-119, 120,
122, 124
menu
displaying 93
displaying main 42
grey options 93
icon bar 94
keystroke equivalents 93, 107109
moving to submenu 94
removing from screen 42, 94
ticked options 93
using Adjust button 42, 93
mode
frame 48, 53, 98
graphics 69, 104
paragraph 26, 84, 100
text 23, 59, 102
modes
Acom Desktop Publisher 10,
13, 45
screen 118, 119, 122, 123
mouse buttons 3

p
page
adding 20, 31-32, 56, 97
deleting 56, 97
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different left and right 9, 56, 79,
80,83
format 9, 13, 78-79
go to 97
numbers 84, 97
viewing at different sizes see view size
page icon 15, 41, 56
page layout 12-13
default 13
Paint 66
paper size 79
paragraph 80
definition 9
indent 83
restyling part of 90
style 9, 26-30, 80-90, 100-101
style, changing 89
style, creating 85-88, 101
style, deleting 90, 101
style, editing 88, 100
style, features of 81
style, flagging in source text 55
style, renaming 90, 101
pica 113
picture
adding 66
adding text to 72
cropping 33-34, 48, 68-69, 100
deleting 67, 100
hiding 67
importing 31-34, 66
placing in frame 66
renaming 67
restoring cropped 34, 69, 100
types of 66
pictures 8
hiding 96
point size 60, 65, 83, 86, 100, 102, 114
very large 65
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pointer
shape 13, 16, 18, 26, 33, 41, 100
polyline 71
portrait format 79
print position 98
printer drivers 116, 118, 120, 121,
122, 123, 127, 128
printing 43, 94, 127
Program disc 115

R
repelling text see text, repelling
rulers 45-46, 96

s
saving document see document, saving
scrolling 125
shape 72
edge 74
filled 74
space
fixed 63, 104, 112
space between letters see letter,
spacing
space between words see word,
spacing
sprite file
importing 66
story
deleting 58, 100
displaying information 57
editing 23
importing 20, 55
pouring into frames 56
renaming 57-58
straight line 70
style
document 8
see also paragraph, style

Index

style sheet 9, 77, 91, 114
saving 95
subhead style 27
submenu
displaying 42
subscript 114
superscript 114

T
tabs 83, 88, 101, 114
decimal 112
tabulation 101
text
copying block 66, 103
cutting block 66, 103
deleting see cutting
editing 60, 61-66
find and replace 62
flush left 30, 101
flush right 101
format 82
italic 113
justified 63, 113
marking block 64
pasting block 66, 103
preparing 54
repelling 24, 51, 58, 99
restyling block 64-65, 100
see also story
styling 60-61, 81
typing in directly 8, 60
toggle 114
toolkit 13, 40
typeface see font

-

v
view size 15-16, 22, 42, 95

w
windows
moving off-screen 4
word
marking 64
preventing split see space, fixed
spacing 82, 87, 101
Work disc 115

z
zooming see view size

u
units of measurement 46, 96
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Reader's Comment Form
Acom Desktop Publisher Guide
We would greatly appreciate your comments about this Guide, which will be taken into account for
next issue:

th~

Did you find the information you wanted?

Do you like the way the information is presented?

General comments:

If there is not enough room for your comments, please continue overleaf

How would you classify your experience with computers?

D
First-time user

D

D
Used computers before

Experienced user

D
Programmer

Your name and address:

Cut out (or photocopy) and post to:
Dept RC, Technical Publications
Acorn Computers Limited
645 Newmarket Road
Cambridge C BS 8PB.

This information will only be used to get in touch with you in case we wish to
explore your comments further.
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